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1 Introduction

1 Introduction

The ImageQuant LAS 4000

The ImageQuant LAS 4000 is a camera system for producing digital images of gel or
membrane samples or films. It is used together with the ImageQuant LAS 4000 Control
Software to:

* Expose chemiluminescent samples or membranes.

* Expose fluorescent samples using epi (incident) or trans (transmitted) light sources,
for example gels stained by ethidium bromide (EtBr).

The ImageQuant LAS 4000 can be supplied with NIR, Red, Green, Blue and UV epi
lights.

* Expose dye-stained gels and membranes or films using epi or trans illumination.

e Expose a sample repeatedly, incrementally or by programming exposure schemes.

Purpose of this manual

The ImageQuant LAS 4000 User Manual provides detailed instructions on using the
ImageQuant LAS 4000 and outlines the functions of the ImageQuant LAS 4000 Control
Software.

Note: Be sure to refer also to the manual Getting Started with ImageQuant
LAS 4000 for regulatory information, specifications and the
troubleshooting guide.

1.1  Important user information

Read this before using the
ImageQuant LAS 4000

3]

All users must read the safety instructions in Getting started with ImageQuant LAS 4000
before installing, using or maintaining the equipment.
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1 Introduction
1.1 Important user information

Do not operate the ImageQuant LAS 4000 in any other way than described in the user
documentation. Otherwise, you may be exposed to hazards that can lead to personal
injury and you may cause damage to the equipment.

Intended use

The ImageQuant LAS 4000 is a camera system that produces digital images of
chemiluminescent, dyed or fluorescent gels and membranes. The ImageQuant LAS 4000
is intended for research use only, and shall not be used in any clinical procedures, or for
diagnostic purposes.

Safety notices

The user documentation contains WARNINGS, CAUTIONS and NOTICES concerning the
safe use of the product. See definitions below.

Warnings

WARNING

WARNING indicates a hazardous situation which, if not avoided,
could result in death or serious injury. It isimportant not to proceed
until all stated conditions are met and clearly understood.

Cautions

CAUTION

CAUTION indicates a hazardous situation which, if not avoided,
could result in minor or moderate injury. It is important not to
proceed until all stated conditions are met and clearly understood.

Notices

&

NOTICE

NOTICE indicates instructions that must be followed to avoid
damage to the product or other equipment.
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1 Introduction
1.1 Important user information

Regulations and standards -
supplementary information

This equipment conforms to the regulations and standards described below.

EMC

Safety

Laser

CE

Note:

Note:

ImageQuant LAS 4000 User Manual 28-9607-42 AC

VCCI Class A Conformance
FCC Part 158 Class A
ICES-003 Class A

IEC 61326-1: 2005

EN 61326-1: 2006

UL61010-1: second edition

CAN/CSA-C22.2 No. 61010-1, second edition
IEC61010-1: 2001, second edition
IEC61010-2-081, first edition

EN 61010-1: 2001

EN 61010-2-081: 2002

USA 21 CFR, Chapter I, Subchapter J, Part 1040.10 Laser Products
IEC 60825-1: 2001

LV Directive 2006/95/EC (as amended)
EMC Directive 2004/108/EC (as amended)
Machinery Directive 2006/42/EC

This equipment has been tested and found to comply with the limits
for a Class A digital device, pursuant to Part 15 of the FCC Rules. These
limits are designed to provide reasonable protection against harmful
interference when the equipment is operated in a commercial
environment. This equipment generates, uses, and can radiate radio
frequency energy and, if not installed and used in accordance with the
instruction manual, may cause harmful interference to radio
communications. Operation of this equipment in a residential area is
likely to cause harmful interference in which case the user will be
required to correct the interference at his own expense.

This Class A digital apparatus complies with Canadian ICES-003. Cet
appareil numérique de la classe A conforme @ la norme NMB-003 du
Canada.

This is a class A product. In a domestic environment this product may
cause radio interference in which case the user may be required to take
adequate measures.



1 Introduction
1.1 Important user information

Information for traceability

Manufacturer: GE Healthcare
Contact information: See back cover
Power cable

1 InJapan and North America:

Do not use cables other than the power cable that comes with the equipment.
2 In EU countries:
The cable is given the following CEE Certification Number.

VDE 6522-1570-8035/AIG DEMKO 116773 ASC
SEMKO 9449029 KEMA 93.6830.04-KCS/LB
NEMKO P94102620 CEBEC 8652

El (FIMKO) 179615-02 OVE 0204-515-00

Mercury-containing products label

CAUTION

Ultraviolet ray lamps in this product contain mercury,
== which must be recycled or disposed of in accordance
with local, state, or federal laws.

LED safety
This product is categorized as a class 1 laser (LED) device (IEC60825-1+A2:2001).

8 ImageQuant LAS 4000 User Manual 28-9607-42 AC



1 Introduction
1.1 Important user information

LED light sources

Red Epi light Wavelength 630nm Class 1
Green Epilight  Wavelength 520nm Class 1
Blue Epi light Wavelength 460nm Class 1

RGB module Wavelength 630,

520 and 460nm Class 1
UV Epi light Wavelength 365nm Class 1M
NIR Epi light Wavelength 710nm Class 1

White Epilight ~ Wavelength 470-740nm  Class 1

CAUTION
Do not look at the light directly through optical instruments.

CAUTION

If the door is opened and the interlock is cancelled, class 1 laser
(LED) will be emitted.

CAUTION

Use of controls or adjustments or performance of procedures other
than those specified in the user documentation may result in
hazardous radiation exposure.

Notes and tips
Note: A Note is used to indicate information that is important for trouble-free
and optimal use of the product.
Tip: A tip contains useful information that can improve or optimize your

procedures.
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1 Introduction
1.1 Important user information

Typographical conventions

Software items are identified in the text by bold italic text. A colon separates menu levels,
thus File:Open refers to the Open command in the File menu. Hardware items are
identified in the text by bold text (e.g., Power switch).

10 ImageQuant LAS 4000 User Manual 28-9607-42 AC



2 The ImageQuant LAS 4000

2 The ImageQuant LAS 4000

This chapter describes the features and part names of the ImageQuant LAS 4000
hardware, and the connectors that connect the various parts of the equipment.

2.1 The ImageQuant LAS 4000 exterior

d t

2

— — 11~
—3
— 4
1— 5
e \‘:'7
—T I —T
7 6
Part Name Description ‘
1 Camera head CCD cooling and image data output
2 Indicator panel Status lights
3 Power LED Lights when the power is on
4 Busy LED Lights when an exposure is in progress
5 Error LED Lights when an error is detected
6 Power switch
| Power ON
O  Power OFF
7 Intelligent dark box (IDX) | Dark box

ImageQuant LAS 4000 User Manual 28-9607-42 AC 11



2 The ImageQuant LAS 4000
2.2 Inside the ImageQuant LAS 4000

2.2

12

Inside the ImageQuant LAS 4000

Part | Name

1 Epi light connector

Description

Connects the epi light to the IDX

2 Epi light source

NIR Epi light (710 nm)

Red Epilight (630 nm)

Green Epi light (520 nm)

Blue Epi light (460 nm)

RGB Module (Epi light with red, green and blue LEDs)
UV Epi light (365 nm)

White Epi light

3 Sample tray

4 Lifting table

Supports the sample

Moves the sample to the selected tray position

5 Lens

F0.85/43 mm LAS High Sens. lens, or

F1.8/24 mm wide view lens

ImageQuant LAS 4000 User Manual 28-9607-42 AC




2 The ImageQuant LAS 4000
2.2 Inside the ImageQuant LAS 4000

Part Name Description

6 Lens connector Connects lens to IDX

7 Automatic filter Used to hold filters selected in the control software.
changer The following filters are commonly used:

IR785 Alexa (filter for NIR LED)

R670 Cys5 (filter for red LED)

575DF20 Cys3 (filter for green LED)
605DF40 EtBr (filter for detecting EtBr)
510DF10 (filter for detecting GFP)
Y515 (filter for blue LED)

L41 UV (filter for UV LED)

8 Trans light source Connects the UV transilluminator or White light table
connector to IDX
9 Trans light source 312 nm UV transilluminator

White light table

Note: Do not use connectors other than those supplied for the Epi light
sources.

Note: Do not connect cables other than those supplied to the lens.

Note: Do not connect anything other than the transmitted light sources to

the transmitted light source connector.

2.5 Connections

Camera head

ImageQuant LAS 4000 User Manual 28-9607-42 AC 13



2 The ImageQuant LAS 4000
2.3 Connections

1 Camera cable
2 USB cable
Note: Do not connect cables other than the camera cable supplied with the
equipment.
Note: Do not disconnect the camera cable other than when removing the

camera head.

LAS High Sens. lens

High Sens. lens cable

Acable used for connecting the LAS High Sens. lens and
the IDX. Make sure that the cable is securely connected.

Note: « Never remove the cable except when replacing the lens.

e Besure to turn off the equipment before replacing the lens.

Epi lights

Connector on Epi light source

The Epi light sources illuminate the object to be imaged
from the upper right and upper left.

The connector is connected to the Epi light source con-

Figure 2.1: Incident (Epi) nector inside the IDX.
flght)source connector
rear,

Epi light source connector

A connector used for connecting the Epi light source.
Power is supplied to the Epi light source through this
connector.

Figure 2.2: Inside the instru-
ment

14 ImageQuant LAS 4000 User Manual 28-9607-42 AC



2 The ImageQuant LAS 4000
2.3 Connections

Note: e The Epi light sources for the right and left sides are different.
Attach the appropriate source on respective sides.

e The connector will be connected when the Epi light source is
inserted. Make sure that the connector is securely connected.
See Section 3.3.2 Changing the Epi lights, on page 31.

e Be sureto use Epi light sources of the same type for the right
and left sides otherwise an incorrect image will be obtained.

« Do notinsert any connector other than those for the Epi light
sources.

USB cable

USB cable

Connects ImageQuant LAS
4000 and the analysis PC.
Read data will be sent from
ImageQuant LAS 4000 to the
analysis PC through the USB
cable. USB 2.0 is supported.

— Connect one end with the Im-
nobisre IMOgeQUOnt LAS 4000 ageQuant LAS 4000 camera
head USB connector, and the
other to a USB port of the
analysis PC.

Note: e Use the USB cable supplied with the equipment.
e Do not connect the instrument and the PC via a USB hub.

e Do not connect USB equipment other than ImageQuant LAS
4000 to the PC. Similarly, do not use other USB equipment con-
nected to the PC while ImageQuant LAS 4000 is in use. This may
result in the loss of image data.

e The PC must be certified according to UL60950-1 (UL listed) and
IEC60950-1.

ImageQuant LAS 4000 User Manual 28-9607-42 AC 15



2 The ImageQuant LAS 4000
2.4 Parts and accessories

2.4 Parts and accessories

L7

Epi tray F0.85 43mm LAS high sensitivity lens

&

Cal plate FL (Green)

{7

White trans tray UV trans tray

Gel sheet

Cal plate GR (Pink) Cal plate DI

White light table

UV transilluminator

16 ImageQuant LAS 4000 User Manual 28-9607-42 AC



2 The ImageQuant LAS 4000
2.4 Parts and accessories

F1.8 24mm wide view lens

RGB module, Epi lights, set of
two
UV Epilight (365 nm), set of two ~ NIR Epi light (710 nm), set of two

Filters:

Y515 filter (Y515)

GFP detection filter (510DF10/GFP)

EtBr detection filter (605DF40/EtBr)

Cy3 detection filter (575DF20/Cy3)

Cy5 detection filter (R670BP/Cy5)

Alexa Fluor 750 detection filter (IR785/Alexa)

Ultraviolet protection filter (L41/UV)

ImageQuant LAS 4000 User Manual 28-9607-42 AC 17



2 The ImageQuant LAS 4000
2.4 Parts and accessories

Note: * The combined accessories and light source vary depending on the
system that you purchase.

* Make sure to retain the caps and filter cases.
e Store the incident (Epi) light sources in a container box.

* The UV trans tray will degrade after many UV illuminations. It can
be used up to approximately 1000 times if each exposure time is 1
second. New trays can be purchased separately.

18 ImageQuant LAS 4000 User Manual 28-9607-42 AC



3 Exchanging accessory parts

3 Exchanging accessory parts

3.1  Changing orinstalling a filter

Optical filters are installed in the filter turret localted under the lens inside the IDX. This
section describes how to install or change a filter on the filter turret.

Install afilter in the filter turrent and register it in the ImageQuant LAS 4000 Control
Software as follows:

¥ ImageQuant LAS 4000
File Edit  Wiew Option  Help

ImageQuan 3
LAS 4000

Change fiker and fiter position

Select Fiters

Through v

Through v

: Through v|
4 Though Through v

5 Through Throush v]

!

(o [ eterdown [ concol |
1

pp—

1 Ensure that the camera head and PC are connected. Turn on the instrument and the
PC, and start the ImageQuant LAS 4000 Control Software.

2 Close the instrument door

J

3 Select Filter Customization in the Option menu in the ImageQuant LAS 4000 Control
Software main window.

4 Click the Filter down button.

ImageQuant LAS 4000 User Manual 28-9607-42 AC 19



3 Exchanging accessory parts

3.1 Changing or installing a filter

The filter changer is lowered.

5 Open the instrument door.

6 Turn the filter changer so the desired position is easily accessible. If a filter is already
in place at this position, unscrew it carefully and put it back in its cover.

7 Screw the new filter into place.

8 Select the appropriate filter from the drop-down list and click the OK button.

Filter Customization

Current Filkers

1: Through
2: Through
3: Through
4: Through

5: Through

Change Filter and filker position

Select Filers

Thi v Through

l:Thl 605DF40
Y515 Di
Thi  s100F10
I:Th' R785
RETO0
57SDF20

[ QK

] I Filter down ] [_ L4

Note:

The filter changer returns to the original position when you click the
Start, Focusing or Method/Tray position buttons.

3.2 Installing or exchanging the lens

Two lenses can be used with the ImageQuant LAS 4000, an F0.85 43mm LAS High Sens.
lens, and an optional F1.8 24mm wide view lens. The wide view lens can image samples
up to 250 x 250 mm in size. For all other applications, the LAS High Sens. lens is
recommended. This section describes how to install or exchange the lenses.

20
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3 Exchanging accessory parts
3.2 Installing or exchanging the lens
3.2.1 Removing the LAS High Sens. lens

F0.85 43mm LAS High Sens. lens | F1.8 24mm wide view lens

3.21 Removing the LAS High Sens. lens

1 Close the instrument door. If the power is turned off and the filter changer is down,
proceed to step 4.

2 Select Option:Lens Exchange.

CCD Calbration...
FlatFrame Calibration. .,
FlatFrame Calibration Fro. .

Fileer Customization. ..
Lens Exchange. ..
Method Setting...

A message is displayed.

Lens Exchange

Close the door and click Ok,

ImageQuant LAS 4000 control software il shut down, Do you want to cantinue?

oK Cancel

3 Click OK.

4 Lens Exchange

Switch off ImageCuant LAS 4000 instrument and change the lens,

Turn off the instrument using the power switch.

ImageQuant LAS 4000 User Manual 28-9607-42 AC 21



3 Exchanging accessory parts
3.2 Installing or exchanging the lens
3.2.1 Removing the LAS High Sens. lens

5 Loosen and remove the lens hood, then place the lens cap over the lens.

Lens hood

6 Disconnect the lens cable connector by rotating the knurling ring.

—~—
éJ’ \/ Knurling ring

‘ ’ , /— Connector of the lens cable
NG

L

PN\,

7 Turn the lens slightly to the left and loosen it while pushing the lens release lever.

Lens release lever

22 ImageQuant LAS 4000 User Manual 28-9607-42 AC



3 Exchanging accessory parts
3.2 Installing or exchanging the lens
3.2.1 Removing the LAS High Sens. lens

8 Rotate the lens to the left by 45 degrees.

The lens comes off downward.

Note: Hold the lens with both hands so as to prevent the lens guide from
being damaged.

9 Take out the lens slowly along the lens guide toward you.

10 Place the end cap on.

ImageQuant LAS 4000 User Manual 28-9607-42 AC 23



3 Exchanging accessory parts
3.2 Installing or exchanging the lens
3.2.1 Removing the LAS High Sens. lens

Note: * Besureto put the high-sensitivity lens sideways and lower it gently

when placing it on the desk. Placing the lens downward may affect
the mechanical precision of the lens barrel.

e Make sure that the filter changer has come down far enough to
make room for replacing the lens.

* Do not let the high-sensitivity lens hang on the lens guide. The lens
may fall causing injury or damage.

* The high sensitivity lens weighs 4.5 kg. Be careful when handling
it.

3.22 Installing the LAS High Sens. lens

1

24

Close the instrument door.If the power is turned off and the filter changer is down,
proceed to step 4.

Select Option:Lens Exchange....

Option ME
€D Calibration...
FlatFrame Calibration. ..
FlatFrame Calibration Pro. ..

Filter Customization, ..
Lens Exchange. ..
Methad Setting. ..

A message is displayed.

Lens Exchange

Close the door and click OK.

ImageQuank LAS 4000 control software wil shut down, Da you want ko continue?

Click OK.

Lens Exchange

Switch off ImageCuant LAS 4000 instrument and change the lens.

Turn off the instrument using the power switch.
Remove the end cap from the lens.

Insert the lens along the lens guide with the red points facing towards you.

ImageQuant LAS 4000 User Manual 28-9607-42 AC



3 Exchanging accessory parts
3.2 Installing or exchanging the lens
3.2.2 Installing the LAS High Sens. lens

7 Connect the lens cable.

Turn the knurling ring until it is securely fixed.

7 I

o

‘ B

-

Knurling ring

, S Connector of the lens cable

=

Y,
NN
N

Note: Be sure to connect the lens cable. Otherwise, the high sensitivity
lens cannot be recognized. This may cause malfunction of the
equipment.

ImageQuant LAS 4000 User Manual 28-9607-42 AC
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3 Exchanging accessory parts
3.2 Installing or exchanging the lens
3.2.2 Installing the LAS High Sens. lens

8 Remove the lens cap.

Lens cap o

9 Install the lens hood.

Lens hood ——

3.23 Removing the wide view lens

1 Close the instrument door. If the power is turned off and the filter changer is down,
proceed to step 4.

2 Select Option:Lens Exchange....

CCD Calibration, .
FlatFrame Calibration. ..
FlatFrame Calibration Pro...

Filter Customization. ..
Lens Exchange. ..
Methad Setting. ..

26 ImageQuant LAS 4000 User Manual 28-9607-42 AC



3 Exchanging accessory parts
3.2 Installing or exchanging the lens
3.2.3 Removing the wide view lens

A message is displayed.

Close the door and click Ok,

ImageQuant LAS 4000 control software wil shut down, Do you want to cantinue?

=3 Cancel

Click OK.
3

Switch off ImageCuant LAS 4000 instrument and change the lens,

Turn off the instrument using the power switch.

4 Remove the F-mount adapter and lens while pushing the release button provided
on the lens.

Remove the wide view lens together with the F-mount adapter by rotating it.
Remove the lens hood from the lens.

Place the lens cap on.

0 N O O,

Place the end cap on the lens and the cap on the F-mount adapter.

3.24 Installing the wide view lens

1 Close the instrument door. If the power is turned off and the filter changer is down,
proceed to step 4.

2 Select Option:Lens Exchange....

CCD Calibration, ..
FlatFrame Calibration. ..
FlatFrame Calibration Pro...

Filter Cuskomization. ..
Lens Exchange. .,
Method Setting. ..

ImageQuant LAS 4000 User Manual 28-9607-42 AC 27



3 Exchanging accessory parts
3.2 Installing or exchanging the lens
3.2.4 Installing the wide view lens

A message is displayed.

Close the door and click OK.

ImageQuant LAS 4000 contral software wil shut down, Da yau want ta continue?

Click OK.
3

Switch off ImageCuant LAS 4000 instrument and change the lens,

Turn off the instrument using the power switch.

4 Remove the cap attached to the F-mount adapter by turning it to the right.

e F-mount adapter

S
(-

5 Remove the end cap from the wide view lens.

6 Align the White point mark of the F-mount adapter with the lens mark and turn to
lock them together. Hold the lens so that the red point is towards you.

F-mount adapter

Wide view lens

28 ImageQuant LAS 4000 User Manual 28-9607-42 AC



3 Exchanging accessory parts
3.2 Installing or exchanging the lens
3.2.4 Installing the wide view lens

7 Fix the lens in position be turning it to the right.

8 Remove the lens cap.

9 Placel the lens hood on the lens.

Lens hood

3.3 Changing the light sources

Both trans (transmitted) and epi (incident) light sources are available for exposure with
the ImageQuant LAS 4000. This section describes how to change both types of light

source.
The following table summarizes the properties of the various light sources.

Peak wavelength

UV transilluminator 312nm

Transmitted
White light table -
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3 Exchanging accessory parts
3.3 Changing the light sources
3.3.1 Changing the UV transilluminator or white light table

Type Name Peak wavelength
UV Epi light 365 nm
Blue Epi light 460 nm
Green Epi light 520 nm
Red Epi light 630 Nm
Incident RGB module (3-color Epi light) | 460nm or
520nm or
630 nm
NIR Epi light 710 nm

White Epi light -

3.3.1 Changing the UV transilluminator or white light table
The UV transilluminator and white light table are exchanged as follows:

1 If neither the UV transilluminator or white light table are currently in place inside the
instrument, proceed to step 4.

2 Turn the lever holding the light source to unlock it.

il

3 Pull out the light source carefully along the guide while holding it with both hands.
4 Push the desired light source in along the guide at the bottom of the IDX.

30 ImageQuant LAS 4000 User Manual 28-9607-42 AC



3 Exchanging accessory parts
3.3 Changing the light sources
3.3.1 Changing the UV transilluminator or white light table

5 Turn the lever at the front to lock the light source into position.

(e} (o}

3.3.2 Changing the Epi lights
This section describes how to change a set of Epi lights. The RGB module Epi lights are
also installed as described here.

Note: The tray should be at tray position 4 before installing Epi lights. If the
tray is higher, then it should be lowered to tray position 4 using the
ImageQuant LAS 4000 Control Software before attaching the lights, as
described below.

Latch

Epi light base

1 Ifthetrayis at Tray position 4, proceed to step 3. Otherwise, close the IDX door.
2 Click on Method/Tray position, set Tray position to 4, and click the OK button.

3 Open the IDX door. If no Epi light is currently in place inside the instrument, proceed
to step 7.

4 Spring up the latch to unlock the Epi light.
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3 Exchanging accessory parts
3.3 Changing the light sources
3.3.2 Changing the Epi lights

5 Holding the latch with one hand, remove the Epi light by pulling it gently outwards.

7 Before installing the new Epi light, ensure that the latch is sprung open (upwards).

8 Hook the hanger located on top of the Epi light to the top edge of the Epi light base.

1 Two guide holes are located on the back of the Epi light base.

2 Slide the hook after attaching the guide pins to the guide holes.

32 ImageQuant LAS 4000 User Manual 28-9607-42 AC



3 Exchanging accessory parts
3.3 Changing the light sources
3.3.2 Changing the Epi lights

9  Push the Epilight while holding the latch open, and slide it inwards until a click sound
is heard.

11 Repeat this process for the opposite side.

Note: * The Epi lights are clearly labelled L for the left and R for the right
sides.

* Installthe Epilights in matching pairs only. If Epi lights with different
wavelengths are used, the intended image will not be obtained.
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4 Operating the ImageQuant LAS 4000

4 Operating the ImageQuant LAS
4000

This chapter describes the ImageQuant LAS 4000 Control Software and how to expose
gels, membranes or films to obtain digital images.

4.1  LayoutofthelmageQuant LAS 4000 Control Software

The exposure of samples in the ImageQuant LAS 4000, the setting of exposure conditions
and the viewing of the digitized images are performed within the ImageQuant LAS 4000
Control Software.

The following illustration shows the features of the main window of the ImageQuant LAS
4000 Control Software.

Description L Description
1 Menu bar 6 The setting state such as the tempera-
ture condition of CCD is displayed.
2 Exposure Type 7 The state of the Intelligent dark box (IDX)
Sets the exposure method is displayed.
3 Exposure Time 8 Method/Tray position
Sets the exposure time. Sets the detection method and tray
position.
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4 Operating the ImageQuant LAS 4000
4.1 Layout of the ImageQuant LAS 4000 Control Software

No. Description ‘ No. ‘ Description
4 Sensitivity/Resolution 9 Focusing

Sensitivity can be set. Adjusts the focus and position.
5 Add Digitization Image 10 Start

Adigitization image is exposed simulta- Starts the exposure.

neously with a chemiluminescence im-

age. (Chemiluminescence method only.)

Note: The software needs to be started once after installing from an account
with administrator priveleges. This is to ensure that necessary folders
and files are created.

4.2  Preparation for exposure

Il

1
f— f—
1

Analyzing PC

Operation

1 Turn on the ImageQuant LAS 4000, computer and peripheral equipment.
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4 Operating the ImageQuant LAS 4000
4.2 Preparation for exposure

Step ‘ Operation ‘

Start up ImageQuant LAS 4000 Control Software.  [EEmarers

ImageQuant LAS 4000 is in self-diagnosis.

A message is displayed until the ImageQuant LAS Ea—
5 4000 is ready. ALY
Note: The power switches of the instrument and PC can be turned on in any
order.

Wait until the CCD has reached the preset cooling temperature and is ready for use.

 imageQuant LAS 4000

Exposure Type
Exposure Time
3 Mo

O Ml

Add Digltization image

[ on
3

Flat frame
i

Method/Tray position LB | Focusing

Tip: * Theinstrument will be ready in a few minutes. The power LED on
the instrument is lit blue when the instrument is ready.

* Method/Tray position and Focusing can be prepared even if the
CCD has not cooled completely.

e The Start button can be clicked even when the CCD is not
completely cooled with the EtBr trans method.

4.3  Calibration

Ensure that the ImageQuant LAS 4000 is properly calibrated. See Section 5.12.1 CCD
Calibration, on page 111 and Section 5.12.2 Flat Frame Calibration, on page 112.
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4 Operating the ImageQuant LAS 4000
4.4 Placing the sample

4.4  Placing the sample

This section describes how to choose an appropriate sample tray, and how to place the
sample for exposure.

1 Select a sample tray suitable for the type of exposure to be performed.

Detection Sample type Tray
Chemiluminescence | Membrane Epi tray
Bioluminescence Titer plate NP tray
Fluorescence Gel (UV Trans illumination) UV trans tray
Gel (Epi illumination) Epi tray
Membrane Epi tray
Digitization Membrane Epi tray
Gel (Coomassie, silver stain) | White trans tray
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4 Operating the ImageQuant LAS 4000
4.4 Placing the sample

2 Place a sample on the sample tray.
For Epi tray
a Place the sample directly on the tray.
For UV or White Trans trays
a Cutout a gel sheet slightly larger than the sample size.

b Place the gel sheet on the Trans tray.

Gel sheet

C Place the sample on the gel sheet.

Note: The gel sheet can be used repeatedly. After use, wash it with mild
detergent, rinse with water then dry well. A gel sheet can be reused
about 20 times.
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4 Operating the ImageQuant LAS 4000
4.4 Placing the sample

3 Choose the exposure size and tray position

For Epi and Trans trays

¢ The readable area varies depending on the tray position. Place the sample in
position according to its size.

250mm X 250mm

210mm X 140mm
180mm X 120mm

144mm X 96mm
105mm X 70mm
I Position 2 !
I Position 3 I
I Position 4 !
| ]
Maximum capture size when a wide view lens is used
Tip: On the Epi tray, there are round dents marked on the tray for
positioning the sample. Line up the sample using the
appropriate dents.
For NP tray
e The NP tray is to be used at tray position 3.
Note: The readable area will be slightly smaller using the F1.8 wide
view lens.
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4 Operating the ImageQuant LAS 4000
4.4 Placing the sample

4 Open the IDX door and insert the tray. Place the Epi or Trans trays in position with
the side with a hole facing outwards.

5 Ensure the lens cap is removed and close the IDX door.

4.5  Exposing chemiluminescent samples

This section describes how to take images of chemiluminescent samples. No illumination
is used for this application.

Place a sample on the Epi tray. Put the tray in the ImageQuant LAS 4000 then close the
door.
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Step

4 Operating the ImageQuant LAS 4000
4.5 Exposing chemiluminescent samples

‘ Action

Click the Method/Tray position button.
Result: The Method/Tray position dialog opens.

Methad / Tray position

Tray position i

@1 L1 |

1 Chendmingscence Mane Through FO.05
2 Fhureseics
[ vz v] | [ | VSISO FO.85
0 twgizaton
() Cprumngtion Write (Ep-Bumingcicn) Through 20
Trans-Buminaton White (Trans mination) Through F28

| 0K | Cancel

o Select Chemiluminescence for Method.
e Select Tray position according to the sample.

e Click the OK button.
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4 Operating the ImageQuant LAS 4000
4.5 Exposing chemiluminescent samples

Step Action

Click the Focusing button.
Result: The focusing controls appear.

Seranlvity / Reschtion
[T

2
Check that the sample is correctly postioned and focus the image.
Click the Return button.
Tip: Click on the image to magnify it. Click on the image again to return
to the original size.
Select Precision for Exposure Type.
Exposure Type
3 \_P v Precision
ExposureT Increment
O futo Repetition
@) Manu Frogram
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Step ‘ Action
Select Auto or Manual for Exposure Time.
Auto
Exposure Type
Exposure Time
& Auto
O Manual
Note: Automatic
exposure
4 time setting
may not be
possible de-
pending on
the sample
type and
method.

Auto 1/155ec

4 Operating the ImageQuant LAS 4000
4.5 Exposing chemiluminescent samples

Manual

Select an exposure time from the drop-down list
or enter the exposure time manually. The exposure
time can be set from 0.01 seconds up to 30 hours.

Exposure Type

Exposure Time
Auto
(& Manual
[0
min

Sensitivity
" ¥ seC

15hr
zhr

Add Digitiz.
[ on

GOmin
30mmin
10min
Smin
2min
Chemiluminesc min

1sec

1/2sec
1/4s8C
Flat frame 1jassc

1/30sex
1/60sex
1/100sec
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4 Operating the ImageQuant LAS 4000
4.5 Exposing chemiluminescent samples

Step

Action

Select Sensitivity/Resolution.

Sensitivity / Resolution
High Resalution
Standard

High
Super
Ultrs
High Binning

Super Binning

Ultra Binning

Note: The check box for Add Digitization Image can be checked to also
perform a white-light exposure, for example to image dye-stained
molecular weight markers. In this case the white epi light should be
in place. Leave unchecked if this is not necessary.

Tip: Select Help:Sensitivity/Resolution.... This opens the following dia-
gram that describes the relation between sensitivity and resolution.

Sensitivityfesolution

= surixapan
= 1mExi2e

axs12

3940298

192128
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4 Operating the ImageQuant LAS 4000
4.5 Exposing chemiluminescent samples

Step ‘ Action

Click the Start button.

Result: The exposure is started. The orange Busy LED lights on the instrument during

exposure.
Exposure Type
Expasure Time
o e e
6 i
Frushing e« &M 0020
TI
7
E1 complete

Click the Complete button.

Result: The display returns to the main screen.

4.6  Exposing fluorescent samples (EtBr)

This section describes how to expose ethidium bromide (EtBr) stained samples using the
UV transilluminator (312 nm).
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4 Operating the ImageQuant LAS 4000
4.6 Exposing fluorescent samples (EtBr)

Place a gel sheet, which has been cut out to be slightly larger than the sample, onto the

UV trans tray. Place the sample on the gel sheet. Put the tray into the ImageQuant LAS

4000 and close the door.

Note: The 605DF40 filter is normally used. If this filter is currently not in the
filter turret, it should be installed. Refer to Section 3.1 Changing or
installing a filter, on page 19.

Note: Ensure that the UV transilluminator is installed. For instructions on
changing the trans light source, see Section 3.3.1 Changing the UV
transilluminator or white light table, on page 30.

& imageuant LAS 4000 E=m

Te TR Ve Optn e
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Step ‘ Action

Methad ! Tray position
Methaod

Click the Method/Tray position button.
Result: The Method/Tray position dialog opens.

Filter

4 Operating the ImageQuant LAS 4000
4.6 Exposing fluorescent samples (EtBr)

Oz L2 |

Tray position

105 x 70 mm

]

iﬂKl

) Chatdmadtends hrd Thidugh LS
() Paoesscence
[ Fibe | (T e i | BOELFAD Fra
©) Coptizption
(=) Ept-Rumingtson white (Ex+-Bumination) Thecusghs 28
Frang-Bumnation Whie (Trans-Rumnaton) Theough (]

~ Cancel l

e Click the OK button.

o Select the Tray position.

o Select Fluorescence as the Method, and choose EtBr from the pull-down menu.
The 605DF40 filter is automatically selected.
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4 Operating the ImageQuant LAS 4000
4.6 Exposing fluorescent samples (EtBr)

Step Action

Click the Focusing button.

Result: The focusing controls appear.

A5 4000
Opten el
ImageQuant

w ¥

Seranivity / Reschation

2
T Arghines I @ '-u'n —
PR
|1 Retun |
Confirm the sample position and focus.
Click the Return button.
Tip: Click on the image to magnify it. Click on the image again to return
to the original size.
Select Precision for Exposure Type.
Exposure Type
3 Pt v Precision
ExposureT Increment

O futo Repstition
@ Manu Pragram
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Step ‘ Action
Select Auto or Manual for Exposure Time.
Auto
Exposure Type
Exposure Time
& Auto
O Manual
Note: Automatic
exposure
4 time setting
may not be
possible de-
pending on
the sample
type and
method.

Auto 1/155ec

4 Operating the ImageQuant LAS 4000
4.6 Exposing fluorescent samples (EtBr)

Manual

Select an exposure time from the drop-down list
or enter the exposure time manually. The exposure
time can be set from 0.01 seconds up to 30 hours.

Exposure Type

Exposure Time
Auto
(& Manual
[0
min

Sensitivity
" ¥ seC

15hr
zhr

Add Digitiz.
[ on

GOmin
30mmin
10min
Smin
2min
Chemiluminesc min

1sec

1/2sec
1/4s8C
Flat frame 1jassc

1/30sex
1/60sex
1/100sec
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4 Operating the ImageQuant LAS 4000
4.6 Exposing fluorescent samples (EtBr)

Step ‘ Action ‘
Select Sensitivity/Resolution.
Sensitivity / Resolution
v High Resalution
Standard
High
Super
Ulra
High Binning
Super Binning
H Ultr Birning
Tip: Select Help:Sensitivity/Resolution.... This opens the following dia-
gram that describes the relation between sensitivity and resolution.
5 | SensitvityResoltion
LAS 4000
Exposure Type
6
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4 Operating the ImageQuant LAS 4000
4.6 Exposing fluorescent samples (EtBr)

Step ‘ Action

Adjust the gradations of the exposed image, then save and print the image.

Fie ER Vew Opten  Hel
ImageQuant
LAS &000

Flat frame
(men

Click the Complete button.
The display returns to the main screen.

Tip: If the Method EtBr UV (Trans-illumination) is used, the Start button
can be clicked and exposure taken even if the temperature setting
state of the CCD is Not Ready.

4.7  Exposing fluorescence (Epi illumination)

This section describes how to expose fluorescent samples using Epi illumination.

Ensure that the correct Epi lights and filter are installed. See Chapter 3 Exchanging
accessory parts, on page 19.

Place a sample on the Epi tray. Put the tray into the ImageQuant LAS 4000 and close
the door.

Note: * Make sure that sample is suitably placed on the tray for the desired

tray position.

* Ensurethat a suitable method exists and that the ImageQuant LAS
4000 is properly calibrated. See Section 4.16 Creating a new method
and performing flat frame calibration, on page 84.
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4 Operating the ImageQuant LAS 4000
4.7 Exposing fluorescence (Epi illumination)

‘ Action

Click the Method/Tray position button.

Result: The Method/Tray position dialog opens.
. =

Method / Tray pasition

) Chenduminescence e Through
() Plaorescence

I (=] x| [ awenmre ] STS0FIN
) Dgtization

(=) Ept-fumination white (Ep-Bumination] Theaugh

2 Tang-Bumnation whits (Trang-Suminetaon) Theough

FO.05.

rz.a
F2.0

144 x 96 mm

]

0K | Cancel

« Select Fluorescence as the Method, choose the appropriate fluorescent marker
and the appropriate light source from the pull-down menus.

The appropriate filter is automatically selected.

o Select the Tray position.

e Click the OK button.
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4 Operating the ImageQuant LAS 4000
4.7 Exposing fluorescence (Epi illumination)

Step ‘ Action

Click the Focusing button.
Result: the focusing controls appear.

Seraitivity | Aeschatan
[ Swaws £

Rapaat Limit
ot Lt

[ times {1..100)

Confirm the sample position and focus.
Click the Return button.

Tip: Click on the image to magnify it. Click on the image again to return
to the original size.

Select Precision for Exposure Type.

Exposure Type

3 Fi w Precision

Exposureq  Incremert
O Ao Repetition
(%) Manu Program
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4 Operating the ImageQuant LAS 4000
4.7 Exposing fluorescence (Epi illumination)

Step

Action

Select Auto or Manual for Exposure Time.

Auto
Exposure Type
Exposure Time
® Auto
) Manual
Note: Automatic
exposure
time setting
may not be
possible de-
pending on
the sample
type and
method.

Auto 1]15sec

Manual

Select an exposure time from the drop-down list
or enter the exposure time manually. The exposure
time can be set from 0.01 seconds up to 30 hours.

Exposure Type
Exposure Time
Auto
) Manual
hr
Sensitivity mn

Sk
Add Digitiz| %"
[Jon

2hr

Gomin
30min
10rmin
Smin
Zmin
Chernilurinesce 1min

tsec

1f2sec
1/4sec
Flat frame 1fasec

1/30sec
1J60sec
1/100sec

54

ImageQuant LAS 4000 User Manual 28-9607-42 AC




4 Operating the ImageQuant LAS 4000
4.7 Exposing fluorescence (Epi illumination)

Step ‘ Action

Select Sensitivity/Resolution.

Sensitivity / Resolution
v High Resolution
Standard
High

Super

Ultra

High Binning
Super Binining
Ultra Binming

Tip: Select “Sensitivity/Resolution...” in the Help menu. You can display
Help that describes the relation between sensitivity and resolution.

axe

1K1

Click the Start button. The orange Busy LED lights on the instrument and a progress
dialog is displayed during exposure.

Adjust the gradations of the exposed image, then save and print the image.
[ ————————————— ]

Fle ER Vew Opten el
ImageQuant™
LAS &000

Exposur Type

Click the Complete button.
The display returns to the main screen.
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4 Operating the ImageQuant LAS 4000
4.8 Exposing dye stained samples and films (White Epi light)

4.8  Exposing dye stained samples and films (White Epi

light)

This section describes how to expose dye-stained samples using white Epi illumination.

For some applications, such as imaging gels stained with Coomassie Blue dye, results
may not be optimal using the white epi light. If the White trans tray is available, see
Section 4.9 Exposing dye stained samples and films (Trans illumination), on page 61 for

a more optimal method.

Place a sample on the Epi tray. Put the tray in the ImageQuant LAS 4000 then close the

door.

Note:
e Prior to exposure, click on

the Digitization Epi-illumi-
nation tab in Edit:Prefer-
ence and make sure that
YES is selected for Invert
Pixel-data. If this is set to
NO, the data will not be in-
verted and the quantitative
value will be reversed.

T
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Step ‘ Action

Click the Method/Tray position button.
Result: The Method/Tray position dialog opens.

4 Operating the ImageQuant LAS 4000
4.8 Exposing dye stained samples and films (White Epi light)

Method / Tray position
Method Ligrht Ful: Iris.
() cramduminescenca Nere Theough oS
) Plarescence
I 1cy3] | [ Grvent -] STS0FIN Fo.B5
O Dgtizsiion
& Eptumination Whikte (Eo-Bumination) Theough rza
O Brsns-Bumnation White (Trares-uminaton) Theough F2.0
.
01
@2
O3 w
O
. 0K | . Cancel |

e Click the OK button.

o Select Digitization and Epi-illumination for Method.

« Select Tray position according to the sample used.
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4 Operating the ImageQuant LAS 4000
4.8 Exposing dye stained samples and films (White Epi light)

Step Action
Click the Focusing button.
Result: The focusing controls appear.
Fie ER Vew Opten  Hel
Ir"u(__:!ef;,‘;ium
2
¥ Brghtnese @ Adu D
FEPD
] Rewrn |
Confirm the sample position and focus.
Click the Return button.
Tip: Click on the image to magnify it. Click on the image again to return
to the original size.
Select Precision for Exposure Type.
Exposure Type
3 Pt v Precision
Exposure T Increment
O futo Repetition
® Manu Frogram
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4 Operating the ImageQuant LAS 4000
4.8 Exposing dye stained samples and films (White Epi light)

Step ‘ Action

Select Auto or Manual for Exposure Time.

Auto Manual
Select an exposure time from the drop-down list
Exposure Type .
or enter the exposure time manually. The exposure
Exposure Tine time can be set from 0.01 seconds up to 30 hours.
Auto
O Manual
Exposure Type
Note: Automatic Expgsure Time
eXpOSufe &) Manual
4 time setting o WD
Sensitivity mn
may not be v s
possible de- Add Digitiz. ="
pending on T —
30min
the sample o
type and s
method Chemilumingsce 1min

1sec
1/2sec
1/4s8C
Flat frame 1jassc
Auto 1/155ec
1/30sex
1/60sex
1/100sec

ImageQuant LAS 4000 User Manual 28-9607-42 AC 59



4 Operating the ImageQuant LAS 4000
4.8 Exposing dye stained samples and films (White Epi light)

Step Action ‘

Select Sensitivity/Resolution.

Sensitivity / Resolution
[ | v HighResolution
Standard

High

Super

Uttrs

High Binning
Super Binning
Ultr Binning

Tip: Select “Sensitivity/Resolution...” in the Help menu. You can display
Help that describes the relation between sensitivity and resolution.

5 Sensiivity/Resalation

= surixapan

= 1538X1024

Maxsiy

3940298

192128

Click the Start button. The orange Busy LED lights on the instrument and a progress
dialog is displayed during exposure.

Adjust the gradations of the exposed image, then save and print the image.

Fie ER Vew Opten  Hel
ImageQuant

4000

x = =] | H!n-..._

E] complete

Click the Complete button.
The display returns to the main screen.
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4 Operating the ImageQuant LAS 4000
4.9 Exposing dye stained samples and films (Trans illumination)

4.9  Exposing dye stained samples and films (Trans
illumination)

This section describes how to expose dye-stained samples using white trans illumination.

Place a sample on the White trans tray. Put the tray in the IDX and close the door.

& imageCuant LAS 4000 [EE1]

Ve Optzn e
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4 Operating the ImageQuant LAS 4000
4.9 Exposing dye stained samples and films (Trans illumination)

Step Action ‘

Click the Method/Tray position button.
Result: The Method/Tray position dialog opens.
|

Method / Tray position

Method Light | S Fitter | Iris

) Chemiluminescence Hone Through F0.85

) Fluorescence

[EtEr] v WY (Trans-ilumination) ¥ 605DF40 Fz.8

(%) Digitization
© Epilumination White: (Epi-illumination) Through F2.6
® Trans-ilumination Wihite (Trans-ilumination) Through F2.8

Tray position

1 _5)
105 x 70 mm
®1
Q2
O Liw [ ]
Q4

‘ oK I‘Cancell

1 Select Digitization:Trans-illumination for Method.
2 Select Tray position according to the sample used.

3 Click the OK button.
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Step ‘ Action

Click the Focusing button.
Result: The focusing controls appear.

Fie £t Vew Opton el

4 Operating the ImageQuant LAS 4000
4.9 Exposing dye stained samples and films (Trans illumination)

ImageQuant
LAS &000
Expasure Type
Expasure Time
Hautn
il
i . -
Sontitrvity | Resalution
-
-
> . READY [ i
Flat frame
F: Bnghtness [ D@ Adust D)
Confirm the sample position and the focus.
Click the Return button.
Tip: Click on the image to magnify it. Click on the image again to return to
the original size.
Select Precision for Exposure Type.
Exposure Type
3 Pl v Precision
Exposure T Increment
O Auto Repetition
@ Manu Prograrn
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4 Operating the ImageQuant LAS 4000

4.9 Exposing dye stained samples and films (Trans illumination)

Step Action

Auto
Exposure Type
Exposure Time
@) futo
O Manual
Note: Automatic ex-
posure time
4 setting may
not be possi-
ble depend-
ing on the
sample type
and method.

Select Auto or Manual for Exposure Time.

Manual

Select an exposure time from the drop-down list or
enter the exposure time manually. The exposure time
can be set from 0.01 seconds up to 30 hours.

Exposure Type

Exposure Time
Auto
() Manual

Sensitivity mn
- ¥ seC

15hr
zhr

Add Digitiz.
[ on

G0min
30min
10min
Smin
2min
Chemiluminesc min

1sec
1/2sec
1/4s8C
Flat frame 1/Bssc
Auto 1/155ec
1/30sex
1/60sex
1/100sec
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4 Operating the ImageQuant LAS 4000
4.9 Exposing dye stained samples and films (Trans illumination)

Step ‘ Action

Select Sensitivity/Resolution.

Sensitivity / Resolution

High Resolution
Standard

High

Super

Ultra

High Binning
Super Binning
Ultra Binning

Tip: Select “Sensitivity/Resolution...” in the Help menu. You can display Help
that describes the relation between sensitivity and resolution.

5 Sensifivity/Resolution

153X 1024
Maxsy

FETTETT)

1w

Click the Start button. The orange Busy LED lights on the instrument and a progress dialog
is displayed during exposure.
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4 Operating the ImageQuant LAS 4000
4.9 Exposing dye stained samples and films (Trans illumination)

Step Action

Adjust the gradations of the exposed image, then save and print the image.

Expasure Type
Expasure Time
Hautn 1 1
- M L
) | P
Senuitrvity / Resalution
v TP |
‘ ..I = |
7 READY ‘ ———
- |
Flat frame
ke _[agtustion ¥ wrs-Sareacon |

=

El complete

Click the Complete button.
The display returns to the main screen.

410 Exposing consecutively (Increment)

The Increment exposure type enables a series of images to be exposed consecutively.
The data for each image is added to the previous images to provide accumulated
exposure data. This section describes how to perform this type of experiment.

Place a sample on the appropriate tray. Place the tray in the ImageQuant LAS 4000 then
close the door.

Note: e Make sure that the tray is placed at the required position.
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4 Operating the ImageQuant LAS 4000
4.10 Exposing consecutively (Increment)

Step ‘ Action

Click the Method/Tray position button.
Result: The Method/Tray position dialog is opened.
p———————————————y

Method / Tray position

) Chemuminescence Pone Through FO.05
) Fuorescenis
[ [cr2] ¥] [ B ¥| Y515 0 FO.BS
7 Dhgtizabon
(&) EprRumnston Wie (Lpi-Bumnstin) Tremign 1]
Trars Buminakion \White (Trans-lmination)) Through F2a

105 % 70 mm

]

O K Cancel

Select the Method and Tray Position.
Click the OK button.
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4 Operating the ImageQuant LAS 4000
4.10 Exposing consecutively (Increment)

Step Action

Click the Focusing button.
Result: The focusing controls appear.

|
Seraitlvity | Arschton

Rapaat Limit
ot Lt

[ times {1..100)

2
Confirm the sample position and focus.
Click the Return button.
Tip: Click on the image to magnify it. Click on the image again to return
to the original size.
Select Increment for Exposure Type.
Exposure Type
3
Interval Ti
Repetition
@ manud Program
= v
Select Interval Time unit and enter a numeric value.
Interval Time
(&) Manual
4 Sensitivity / Res
Repeat Limit
[ set Limit
Note: Interval Time can be entered in the range of 10 seconds to 2 hours.
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4 Operating the ImageQuant LAS 4000
4.10 Exposing consecutively (Increment)

Step ‘ Action
Select Sensitivity/Resolution.
Sensitivity / Resolution
High Resalution
Standard
High
Super
Ulkra
High Birming
Super Binning
Ulkra Binning
Tip: Select “Sensitivity/Resolution...” in the Help menu. You can display
Help that describes the relation between sensitivity and resolution.
5
Sensiivity/Roesolution
To specify the maximum number of exposures to be taken, check the Set Limit check
box and specify the number of images.
6

Repeat Limit
Set Limit

times (1..100)
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4 Operating the ImageQuant LAS 4000
4.10 Exposing consecutively (Increment)

Step Action ‘

Click the Start button to begin exposure.
The index view and expanded view can be switched by clicking the Index or Image

tab.
Note: The displayed expanded image is the latest image.
Index view Image view

s WY,
| Avsly A1 |
| feset |

-

Exposure automatically stops after the number of images set in Repeat Limit.

Note: Clicking the Stop button cancels the current exposure.

Tip: It is possible to stop exposures automatically when the image is
saturated. This function is activated in Edit:Preference under the
Increment tab.
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4 Operating the ImageQuant LAS 4000
4.10 Exposing consecutively (Increment)

Step ‘ Action

Tip: During exposure, the gradation conversion curve can be changed
and the gradation adjusted.

When the Apply All button is clicked, the adjusted gradation will be
applied to allimages.

Apply All
Reset All

. Description No. | Description
1 The range can be 4 The changed gradation
changed by dragging is applied to allimages.
the mouse.
2 The gradation conver- 5 Return to initial setting.

sion curve can be tog-
gled between Linear or
Sigmoid.

3 The gradation can be
changed by dragging
the mouse.

Adjust the gradations of the exposed image(s) as described above, then save and print
the image(s).

Click the Complete button.

The display returns to the initial screen.

Note: Only the last 100 images can be kept. Previous images are discarded.

411 Exposing repeatedly (Repetition)

The Repetition exposure type enables a series of images to be exposed consecutively.
Each image is recorded separately and data is not accumulated. This section describes
how to perform this type of experiment.

Place a sample on the tray that you selected according to the type of a sample. Put the
tray in the ImageQuant LAS 4000 then close the door.

Note: * Make sure that the tray is placed at the required position.
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4.11 Exposing repeatedly (Repetition)

Step ‘ Action

Click the Method/Tray position button.
Result: The Method/Tray position dialog is opened.

Method / Tray position
[ ethod o [ e | |
&) Chemuminescence Mone Through FO.05
) Fuorescence
[ [er2] ¥ B ¥| YE15 0 FO.BS
) Dgtizaton
(5] Ep-lurminstion et (L p-Bumination] Theough P2
Trans Suminakion \White (Trans-lmination) Through L
' e
105 x 70 mm
(OF]
Oz
(o}
OK | Cancel
Select the Method and Tray Position.
Click the OK button.
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4.11 Exposing repeatedly (Repetition)

Step ‘ Action

Click the Focusing button.

Result: The focusing controls appear.

Confirm the sample position and focus.
Click the Return button.

Tip: Click on the image to magnify it. Click on the image again to return
to the original size.

Select Repetition for Exposure Type.

Exposure Type

3 Re Precision

- I t
Interval Tin "o
v Repettion

() Manu;  Program

Select Interval Time unit and enter a numeric value.

Interval Time

® Manual
O ow
4 Sensitivity / Res|

Standar S

Repeat Limit
[] Set Limit

Note: Interval Time can be entered in the range of 10 seconds to 2 hours.
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4.11 Exposing repeatedly (Repetition)

Action ‘

Step
Select Sensitivity/Resolution.
Sensitivity / Resolution
[ | v HighResolution
Standard
High
Super
Ulra
High Binning
Super Binning
Ultr Birning
Tip: Select “Sensitivity/Resolution...” in the Help menu. You can display
Help that describes the relation between sensitivity and resolution.
5
Sersiivity/Resolution
TIRINAN
- 1536X 1024
Maxsi2
AN
192x128
To specify the maximum number of exposures to be taken, check the Set Limit check
box and specify the number of images.
6 Repeat Limit
Set Limit
times (1..100)
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4.11 Exposing repeatedly (Repetition)

Step ‘ Action

Click the Start button to begin exposure.
The index view and expanded view can be switched by clicking the Index or Image

tab.
Note: The displayed expanded image is the latest image.
Index view Image view

Exposure automatically stops after the number of images set in Repeat Limit.
Note: Clicking the Stop button cancels the current exposure.
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4.11 Exposing repeatedly (Repetition)

Step Action ‘

Tip: During exposure, the gradation conversion curve can be changed
and the gradation adjusted.

When the Apply All button is clicked, the adjusted gradation will be
applied to allimages.

- Apply All

Reset All

Description No. Description

1 The range can be 4 The changed gradation
changed by dragging is applied to allimages.
the mouse.

2 The gradation conver- 5 Return to initial setting.

sion curve can be tog-
gled between Linear or
Sigmoid.

3 The gradation can be
changed by dragging
the mouse.

Adjust the gradations of the exposed image, then save and print the image.
8 Click the Complete button.
The display returns to the initial screen.

Note: Only the last 100 images can be kept. Previous images are discarded.

412 Printing exposed images

The exposed image can be output as a full-scale print or screen print (the window
displayed on the screen). The print can be done using the Print button displayed in the
post-exposure state or the File:Print. This section describes how to print an image.

Action

For a screen print, first display the window you wish to output.

Click the Print button or select Print from the File menu.
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4.12 Printing exposed images

Step ‘ Action

Select the output setting for the printer and the type (full-scale print, paper-size print
or screen print). Click the OK button.

Full-scale print

Paper-size print  — O By P
2 Screen print SR
C=] ol

The Print dialog is displayed. Choose settings for the printer and click the Print button.

The image is printed.

Tip: Exposure information is printed together with the image (except for
the Easy Print option). This is convenient since it is unnecessary to
note the exposure information and the conditions. The following
exposure information is included:

Exposure date, camera serial number, lens type, cooling temperature
at the time of exposure, exposure type, sensitivity, exposure time (or
interval time), name of Method, tray position number, values at both
ends of the range scope, values at both ends of the gradation, type
of gradation, Control Software version number.

Nov Wed 25 15:25:14 2009 Serial#1234567 FUJINON VRFA3LMD Cooling-25C Precision Stondord
1sec Chemiluminescence Tray Position
Range:512-4607 Gradation:512-4607 Linear ImageQuant LAS 4000 mini 1.1.0.17

Image

413 Saving exposed images

The exposed image can be saved using the Save button displayed in the post-exposure
state or by File:Save. This section describes how to save an image.

1 Click on the Save button or select File:Save.
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4.13 Saving exposed images

Step Action
When the Save Function screen is displayed, select one of the following 3 saving methods
to save the photographed image.
Click Next button.
[ () Save selected images 3 v|- 3 v
2 —l— O Save displayed images
3 ) Makeintegrated image l:’ B l:’
4 N Save passed images { Up to 84 images )
5 _Cumrnent: |
No. Description Description
1 Save Selected Image Save Images in temporary folder
(Exposure Type: Increment, Repe- (Max84)

2 tition, Program) Image files not displayed in the
For multiple files, specify the Index view are saved in the 100
range of files to be saved. latestimages (maximum 84 files).

2 Save Display image (Max16) Comment
(Exposure Type: Increment, Repe- When the file is saved in gel for-
tition, Program) mat (*.gel), a comment can be
Allimage files displayed in the in- entered in the file.
dex view are saved (maximum 16 When the file is saved in TIFF for-
files). mat, the comment will not be

saved.

3 Make Increment Image
(Exposure Type: Program only)
Files of multiple exposures are
accumulated and saved.
The range of image files to be
processed in accumulation can
be specified.
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4.13 Saving exposed images

Step ‘ Action
The Save dialog is displayed. Type in a File name and press the Save button to save the
file.
Save
Savein [ ) LAS4000Image R i 1
M;%m
Dacuments
E
Desktop
My Dﬁnents
My‘%iler
Mgﬁolk File name:; I —'_"l—ﬁ-— 2
Places
Saveastype: | Gel File Format(".gel) —;I%I—— 3
|
3

No. Description

1 Select where to save the file.

2 The file name is set automatically but may be replaced.

File names for single and programmed exposures are automatically
set in the format <FileName>_n, where n is the next available index.
Forimages taken in exposure type Increment, file names are automat-
ically set in the format <FileName>_n_N_<TotalTime>, where n is the
next available index, N the total number of exposures and TotalTime
is the total exposure time for the image.

3 Select a file format. The .gel format is a GE Healthcare format that
records details of the exposure. Such details are not saved in .tif for-
mat.

Tip: To automatically launch an external application to view images upon
saving, refer to Launch Applicaton, on page 105.
Note: Special characters such as \, *, / or other characters that have a special
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4.14 Ending the session

414 Ending the session

This section describes how to end the current session with the ImageQuant LAS 4000.
The instrument should be switched off as described below when it will not be used for
some time.

Step Operation ‘

Select Quit from the File menu.

% ImageQuant LAS 4000
ST Edit  View Option  Help

1 Page Setup... nt"
Frirt... P

Save...

Quit

Select Stop the CCD cooling now and click OK.

(®) Stop the CCD cooling now,

() Keep the CCD cooling after quit.

C o] [

Tip: When Keep the CCD cooling after quit is selected, the cooling tem-
perature of the CCD will be maintained and the instrument can be
used straight away the next time the ImageQuant LAS 4000 Control
Software is started. In this case, do not turn off the ImageQuant LAS
4000. However, if the instrument will not be used for a long period,
it should be turned off.

3 Shut down the computer.

4 Switch the ImageQuant LAS 4000 off using the power switch.

415 Exposing large sample using wide view lens

Alarger sample (of up to 250 x 250 mm) can be exposed by replacing a high-sensitivity
lens with a wide view lens. This section describes how to expose large samples.

Action

1 Install the wide view lens. See Section 3.2 Installing or exchanging the lens, on page 20.
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4.15 Exposing large sample using wide view lens

Step
Place a sample on the tray that you selected according to the light source used.
Put the tray in IDX and close the door.
& imapeduast | A5 4000
Fle G0 vew Opion el
.-.'.;L‘\')I"';:Z:" =
2
| | o
Flat fra
Click the Method/Tray position button.
Method / Tray position
) Chemiluminescence Nane: Through F0.85
(&) Fluorescence
[ [EtE] ] [ v (rans-luminationy ¥ ] S0SDF40 Fz.8
) Digitization
() Eprilumination ‘White: (Epi-ilumination) Through F2.8
Trans-llumination White {Trans-llumination) Through F2.6
105 x 70 mm
3 ou
@1
: ]
QO3 P
 Next | Cancel |
1 Select the Method, Light source, Filter, Iris, and Tray position.
2 If FlatFrame Mode is set to manual in Edit:Preference, click the Next button.
3 Select the appropriate Flat Frame file.
4 Click the OK button.
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4.15 Exposing large sample using wide view lens

Step Action

Click the Focusing button.

Using for example some printed text on the sample tray, turn the lens while viewing the
screen, and adjust the focus manually.

Click the Return button.

Tip: Click on the image to magnify it. Click on the image again to return to
the original size.

Select Exposure Type.

Exposure Type

5 Pl v Precision

Exposu reT Increment
O Auto R.epetition
) Manu Progranm

6 Set the Exposure Time or Interval Time.
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4.15 Exposing large sample using wide view lens

Step ‘ Action

Select Sensitivity/Resolution.

Sensitivity / Resolution
High Resclution
Standard

High

Super

Ultra

High Binning
Super Binining

Ultra Binning

Select Sensitivity/Resolution... in the Help menu. You can display Help

Tip:
that describes the relation between sensitivity and resolution.
7
Sensiivity/Resolution
g Click the Start button.

Exposure is started.
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4.15 Exposing large sample using wide view lens

Step Action ‘

Adjust the gradations of the exposed image, then save and print the image.
Click the Complete button.

ImogeQuant
0

LAS 00

Expoiune Type

Exposure Tima
O e

Reset All El complete

The display returns to the main screen.

416 Creating a new method and performing flat frame
calibration

For most purposes a pre-existing method will be sufficient. For other filter, light source
and iris combinations a new method needs to be created. The following describes how
to create a new method and perform a Flat Frame calibration.

Step Operation ‘

In Preference in the Edit menu, select FlatFrame mode, and set this to Manual.
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4.16 Creating a new method and performing flat frame calibration

Step ‘ Operation
To create a new method click Method Setting in the Option menu. The Method Setting
dialog opens.
Method List
Mame = Light Filter Tris o]
[Cyz (RGE)] 3 e (EpiRGE) @ vsisoi Fo.ss
[cvz] B Biue (EpiBlue) @ vsisoi Foss
[Cy3 (RGE)] B Green (EpiRcE) @ s7soF20 Fo.es
2 [Cyva] B3 creen(EpiGreen) @ S7SDFe0 Fo.85
[Cy5 (RGE)] I red (EpiRaE) @ re7n FO.85 ||
[Cys] I red (Epired) @ re70 FosS
[oaPT] | - G [~ e F2.8
[Digitization Epi-lurination] [ white (Epi-white) (O Through | Fz.a
[Digitization Trans-ilumination] [ White (Trans-white) | () Through [F2.8 b
Select an existing method to change and click the Edit button, or to create a new
method click Add.
The Method Setting edit dialog opens.
Method Setting ‘
3 Mame: |TomsMethod |
Light: |.Elue (Epi-Blue) v‘
Fiter: |. R7E0 v‘
Iris: |FU‘BS v‘
Select the appropriate Light, Filter and Iris, edit the Name for the method and click
4 OK.

Once the method is added to the list of methods, click OK to return to the main window.
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4.16 Creating a new method and performing flat frame calibration

Step Operation ‘
Insert the calibration plate appropriate for the light source into the ImageQuant LAS
4000.
Light source ‘ Calibration plate ‘
Red Epi light Cal plate GR (pink)
Green Epi light | Cal plate GR (pink)
Blue Epilight Cal plate FL (green)
5 RGB module Use the Cal plate that corresponds to the chosen wavelength
(red, green or blue)
NIR Epi light Cal plate GR (pink)
UV Epi light Cal plate FL (green)
White Epilight | Cal plate DI (white)
Close the door of the instrument.
Note: Ensure the the appropriate lights and filter are in place.
To perform a Flat Frame calibration, select FlatFrame Calibration in the Option menu.
The FlatFrame Calibration dialog opens.
6
Note: Administrator priveleges are required in order to perform a Flat Frame
calibration.
7 Select the method to calibrate from the drop-down list. Choose which tray positions
to calibrate, then click Start to begin the calibration.
8 Once the calibration is complete, click the Close button to close the dialog. The calibra-
tion plate can now be removed.
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5 Software reference guide

51 Exposure type

This function is for selecting exposure methods. There are four types of exposure methods.

Exposure Description

Type

Precision Exposes for the entire time set in Exposure Time.

Increment Exposes for each time set in Interval Time and accumulates images.
Repetition Exposes for each interval time set in Interval Time and displays

images for each section.

Program Exposure is made for the desired time and exposure intervals. A file
is created automatically for each read image, and the file of accu-
mulated images is also saved automatically.
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5.1 Exposure type

(o ¢ Yot o o | N
Sets the exposure time D>
and createsoneimaged _ _ _ _ _ _ _ _ _ _ _ _ _ _ o o .
Increment—= >
Sets the exposure W
interval and creates
multiple accumulated | B | > Image 2
: —
images. image 2
HCm >
Imaga 3
Repetition—=& >
Sets the exposure | Imaga 1
interval and creates
multiple images. —a >
Image 2
(— R
Image 3
Program >

Daslred exposure tims| Image 1
and exposura interval

are set, and multiple >

images are created.

Image 2
E: s G ] | 3
Expesura Intarval (Walt) = >
preset in Image 2.
Exposurs intarval (Wait) | >
presel in Image 1. Exposure interval {Wait) mage 4
presat in Image 2. o - - 2
{File only)

Exposure interval (\Wait)
presel in Image 4.

Y

Exposure time

5.2 Exposure time

This function is for setting the exposure time.

When exposure type is precision

e Auto: The exposure time is automatically calculated by histogram analysis.
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5.2 Exposure time

Manual: Select a suitable exposure time from the drop-down list. Alternatively select
a time unit and type in an exposure time.

Exposure Time
Auto

() Manual
10 hr
Sensitivity | ™"
¥ seC
High F

15hr
zhr

BOmin
30mir
10mir
Srmin
Zmin
Chemiluminesce 1min

1sec
1/zsec
1/4sec

Flat frame 1fasac
Bk 1/15s2c :l
1/30sec
| weosec
- 1/100sec

When exposure type is increment
or repetition

Choose a time unit from the drop-down list and enter an interval time.

Interval Time
& Manual
hr
Sensi(ivir);:’a:i
Tip: The interval time can be set from 10 seconds to 2 hours. For a UV
transmitting light source, the interval time can be set from 10 seconds
to 1 minute.
Note: An image can be exposed for up to 30 hours in Precision mode.

However, the image quality and quantitative performance are only
guaranteed for a maximum of 2 hours.

5.3  Add digitization image

Add Digitization image
anN

A chemiluminescence and a white-light epi-illuminated image are exposed by single-click
operation when this function is set to ON. After exposure, both chemiluminescence and
white epi-illuminated images can be saved.

This function can be used only when the method is chemiluminescence.
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5.3 Add digitization image

Tip: Click on Digitization Epi-illumination in Preference in the Edit menu,
and select YES for Invert Pixel-data.

5.4  Program settings

Program Settings are used to set exposure time and exposure intervals when Program
mode is selected as Exposure Type. The input settings are saved as a template file.

12 11
1 —— e | mm/»&e 7 vl
ey ' et
e
> Image 1 Image 2
3 14— e e [1 s ¥] | exposue

. s Eponrs 1
=+l :
Bgone 1 [
Image 14
9 — 4
File name : ‘ File Format : [ Gl File Format(*,gel)
Save Fokder : | ClDocuments and ... ant LAS 4000\ mage |
4 ~
= Save As Template | | Reset | \ \ ——38
\
\
5 6 7
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5.4 Program settings

Description b Description
1 A template file is selected. If a new 7 Select the image file format to be saved.
template is to be created, select New Note: Two types of format
Template. can be selected, the
Note: When the selected GE Healthcare gel
template is modified, format (*.gel) and a
Modified will be dis- linear 16-bit
played. grayscale tiff file for-
mat (*.tif).
2 Set exposure intervals. This is the time | 8 Close the settings window.

from the shutter closure until the start
of the next exposure.

Note: The wait time can be
set within the range
of 0 seconds to 30
hours.
3 Set exposure time. 9 Enter a file name to be saved.
Note: This can be set within
the range of 0.01
seconds to 30 hours.
4 Save the template. 10 Enter a comment.
5 Settings will return to the initial settings. | 11 Select the number of frames (between

1 and 16) to be preset.

6 Folder in which the template is saved 12 Select detection sensitivity.

Delete a template
Navigate to the folder chosen in step 6 above and delete the template file.
The default locations are as follows:
* For Windows XP

C:\Document and Settings\All users\Application Data\GE Healthcare\ImageQuant
LAS 4000\ProgramTemplate

* For Windows Vista
C:\GE Healthcare\lmageQuant LAS 4000\ProgramTemplate

ImageQuant LAS 4000 User Manual 28-9607-42 AC 91



5 Software reference guide
5.5 Focusing

55 Focusing

The Brightness function enables adjustment of the brightness of the Focusing screen,
and the Adjust function enables adjustment of the focus when the LAS High Sens. lens
is used.

= imageQuant LAS 4000

Exposure Type

Exposure Time
Mso

Marusl
i1l

H
4

Sensitivity / Resolution =

ghiiewhton ¥

READY [ ='C

Enptization.

Flat frams
s

% Brightness g e Adus D D
S

Description

1 Click on theimage to expand or reduce | 4 Coarse adjustment of focus.
the display.

2 The view of the focusing screen be- 5 Fine adjustment of focus

comes darker.

3 The view of the focusing screen be-
comes lighter.

Tip: Select Pan Focus Fast in the View menu. The focusing speed then
increases.
This is effective for the alignment of a sample (see Pan Focus Fast, on
page 110).

Note: * When the NP tray is used, adjust so that the bottom of a plate is

focused. Adjustment using a printed paper facilitates focusing.

* Check the tray positions to be exposed in advance.
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5.6 Start

56 Start

Exposure starts when you click the Start button.

During exposure (type Precision)

During exposure, a progress bar and ending time are displayed to indicate the progress
status of exposure.

% ImageQuant LAS 4000
File Edit Wiew Option Help
mageQuant
LAS 4000

Exposure Type

Exposure Time
Auto
Manual

30 sec W

Sensitivity / Resolution

High Resoltion ¥

Exposure Time : 30sec
Finishing Time :  AM 09:40

Exposing...

Fluorescence

[EtB]

Flat frame
Auto

Click Cancel to discontinue exposure. The current image is not saved.
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5.6 Start

During exposure (type Increment
or Repetition)

Range Scope can be changed by drag-
ging the mouse.

The changed gradation is applied to all
images.

Gradation can be changed by dragging
the mouse.

Exposure is discontinued.

The current image is discarded.

Gradation conversion curve can be
changed (linear or sigmoidal).

Click this tab to enter index view.

Returns the gradation to the initial set-
ting.

Click this tab to magnify the selected
image.

Tip: * Exposure is interrupted when you click the Stop button during
Precision exposure. In this case, the image in course of exposure

is not saved.

* When you click the Apply All button during magnified image
display, the gradation changed in the expanded image display
state is applied to all magnified images.

Note: Only the 100 latest exposed images can be saved for exposure types

Increment and Repetition.
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5.6 Start

During exposure (type Program)

Description b Description
1 The range can be changed by dragging | 6 Exposure is discontinued.
the mouse. The current image is discarded.
2 Gradation canbe changed by dragging | 7 Click this tab to enter index view.
the mouse.
3 The gradation conversion curve canbe | 8 Click this tab to magnify the latest im-
changed (linear or sigmoidal). age.
4 Return to initial setting. 9 Preset conditions.
5 The changed gradationis appliedtoall | 10 The area where an image will be dis-
images. played.
Tip: * Images for which exposure is completed are automatically saved

in a file with name format:
<FileName>_<PhotographNo.>_<ExposureTime>

* Animage, which is the accumulation of all exposed images is
saved in a file with name format:
<FileName>_<Sum>_<TotalExposureTime>

Note: Only the 16 latest exposed images can be saved for exposure type
Program.
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5.6 Start

After exposure (type Precision)

Y

ImageQuant™
LAS 4000

Description

Description

changed (linear or sigmoidal).

1 The range can be changed by dragging Print image or screen.
the mouse.

2 Gradation can be changed by dragging Save image.
the mouse.

3 The gradation conversion curve can be Return to main screen.

96
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5.6 Start

After exposure (type Increment,
Repetition or Program)

For magnified image view For index image view

The range can be changed by dragging
the mouse.

Return to main screen.

Description

Gradation can be changed by dragging
the mouse.

Save image.

The gradation conversion curve can be
changed (linear or sigmoidal).

Print image or screen.

The changed gradation is applied to alll
images.

The selected image is marked by a yel-
low frame. Click on an image to select
it. Double-click an image or click the
Image tab to open the magnified image
view.

Returns the gradation to the initial set-
ting.

Sensitivity/Resolution

This function sets the sensitivity and resolution.

The relation between the sensitivity and resolution is shown below.
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5.7 Sensitivity/Resolution

Sensiivity/Resolution

: 0TIRIIAN

= 1538X1024
reaxsiz
40246

192128

File size for each sensitivity

High Resolution  12.6MB

Standard 3.15MB
High 3.15MB
Super 3.15MB
Ultra 3.15MB

High Binning 786MB
Super Binning 197MB

Ultra Binning 49.2MB

Tip: Select Sensitivity/Resolution...in the Help menu. The relation between
the sensitivity and resolution is displayed.

5.8  Method/Tray position

The window for setting the method and tray position is displayed when you click the
Method/Tray position button. Select a method and tray position most suitable for the
sample and click the OK button.

98 ImageQuant LAS 4000 User Manual 28-9607-42 AC



5 Software reference guide
5.8 Method/Tray position

Method / Tray position

[of
03 g
04

Method ght
) Chembumingscence Hane
F) Fuorsscme
[ cr2] )l B v]
per—
&) Epklumington WWhite (EpkBuminstion)
Trans- Buminnhon Wit (Trans-lmination)

@ L |

Filter

Through

VSIS DI

Thenugh
Theough

Tray position o

L
FO.05
FO.85
F2.0
F2a
- 0K | cancel

Set the method and tray position

Method

The method (the combination of the optimum light source, filter, and iris) is registered
for each detection method. When a method is selected, the light source, filter, and iris
are set automatically. The contents of each setting are shown in the table below.

Note: The RGB module may be used instead of the separate red, green and
blue Epi lights.

Method Option Light Filter ‘ Iris

Chemiluminescence None Through F0.85
SYBR Green Blue (460nm Epi) Y515 Di F0.85
GFP Blue (460nm Epi) 510DF10 | FO.85
EtBr UV(312nmTrans-il- | 605DF40 | F2.8

lumination)

Fluorescence Cy2 Blue (460nm Epi) Y515 Di F0.85
Cy3 Green (520nm Epi) | 575DF20 | F0.85
Cy5 Red (630nm Epi) R670 F0.85
Dy781 NIR (710nm Epi) IR785 F0.85
DAPI UV (365nm Epi) Lal | F2.8
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5.8 Method/Tray position

Method

Filter

Iris

Digitization

Epi-illumina- | White (Epi-illumina- | Through F2.8
tion tion)

Trans-illumina- | White (Trans-illumi- | Through F2.8
tion nation)

Note:

Note:
Note:

The method that can be used varies depending on the state of the light
source set in IDX. Unusable options cannot be selected.

Before clicking the OK button, be sure to close the IDX door.

Filter position 1 is dedicated for chemiluminescence. Do not put a filter

init.

Tray position

The tray position is changed according to the sample size.

The tray size that can be read varies depending on the tray position.

Position ~ Width (mm) Length (mm)
1 105 70
2 144 96
3 180 120
4 210 140
250 (wide view lens) 250 (wide view lens)

Position 1

100

—

250mm 250mm

210mm 140mm

180mm T20mm

144mm 96mm

105mm 70mm
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Tip:

5 Software reference guide
5.8 Method/Tray position

e The display on the main window changes to reflect the current
choice of method and tray position.

e The NP tray is to be used at tray position 3 using the
Chemiluminescence method and the NP check box should be
checked. The tray will not be detected otherwise.

Manual flat frame mode

In order to be able to manually specify a Flat frame file for the method and tray position,
set FlatFrame Mode to Manual in Edit:Preference. Click Next in the Method/Tray position
dialog to select the appropriate Flat Frame Correction.

ImageQuant LAS 4000 Preference

CCD Cooling
Root Folder
File Farmak

Prink Adjust
Increment

Timer
Auko Range

FlatFrame Mode
Launch Application

Digitization Epi-ilumination

@) Auto ) Manual

Tip:

Note:

5.9 Filemenu

Page Setup

Only Flat Frame files that satisfy the currently selected exposure
conditions are displayed in the Flat Frame Correction list.

To create a Flat Frame file, see the description of the Flat Frame
Calibration function, Section 5.12.2 Flat Frame Calibration, on page 112.

Before clicking the OK button, be sure to close the instrument door.

Opens the settings for the printer, for example the direction of paper.
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5.9 File menu

Print

Save

Quit

Outputs an image to a printer.

The image can be printed as a full-scale print or screen print. For the output method,
see Section 4.12 Printing exposed images, on page 76.

Saves a file. The default setting for the file format to be saved is that selected in Preference
in the Edit menu. See Section 5.10 Edit menu, on page 102.

Exits ImageQuant LAS 4000 Control Software.

510 Edit menu

Cut

Copy

Paste

102

Cuts the selected characters. This function can be used during manual input of exposure
time and interval.

Copies the selected characters. This function can be used during manual input of exposure
time and interval.

Pastes the copied characters. This function can be used during manual input of exposure
time and interval.
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5.10 Edit menu

The available settings can be viewed by clicking the respective item.

CCD Cooling

Sets the CCD temperature.

ImageQuant LAS 4000 Preference

CCD Cooling

Foot Folder

File Farmat

FlatFrame Mode

Launch Application

Prink Adjust

Increment

Digitization Epi-ilumination
Timer

Auto Range

CCD Cooling Temperature

- B,
:

Root Folder

Sets the folder in which files are saved.

ImageQuant LAS 4000 Preference

CCD Cooling

Root Folder

File: Format

FlatFrame Mode

Launch Application

Print Adjust

Increment

Digitization Epi-illumination
Timer

Auko Range

C:\Documents and Settings\TE. .. .ts\ImageQuant LAS 40004 Image | ’ Select...

Cancel
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5.10 Edit menu

File Format

Select the default format for saving images.

ImageQuant LAS 4000 Preference

CCD Cooling

Root Folder

File Farmat

FlatFrame Mode

Launch Application

Print Adjust

Increment

Digitization Epi-ilumination
Timer

Auko Range

(el File Farmat(*.gel) w

104

Gel File Format (*.gel)

Linear 16-bit grayscale encoding. Can include additional information compared to
tif format.

Original Image TIFF File-Linear 16bit Gray (* tif)
This is a 16-bit TIFF format.

Window Image TIFF File-8bit Color (* tif)
This is a TIFF format that has an eight-bit color gradation.

The changed gradation can be saved directly.
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5.10 Edit menu

FlatFrame Mode

Option

ImageQuant LAS 4000 Preference

0 Cooling

Rook Folder

File: Format

FlatFrame Mode

Launch Application

Print Adjust

Increment

Digitization Epi-illumination
Timer

Auto Range

(&) Auto O Manual

Description

Auto Optimal correction data is automatically set.
Manual Correction data can be selected in the Flat Frame selection screen.
Launch Applicaton

This option can be used to automatically launch an external application when an image
is saved.

ImageQuant LAS 4000 Preference

CCD Cooling

Foot Folder

File Farmat

FlatFrame Mode

Launch Application

Prink Adjust

Increment

Digitization Epi-ilumination
Timer

Auto Range

[ activate save and launch Function

To define an application to launch, do the following:

Cancel

ImageQuant LAS 4000 User Manual 28-9607-42 AC 105



5 Software reference guide

5.10 Edit menu

Print Adjust

106

Select the application to be launched from the drop down list, or locate the application
using the Select... button.

Check the Activate save and launch function checkbox.

Adjusts the print output size.

ImageQuant LAS 4000 Preference

CCD Cooling

Root Folder

File Format

FlatFrame Mode

Launch Application

Print Adjust

Increment

Digitization Epi-ilumination
Timer

Auto Range

Height

o

100,
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5.10 Edit menu

ImageQuant LAS 4000 Preference

0 Cooling

Rook Folder

File: Format
FlatFrame Mode
Launch Application
Print Adjust
Increment

Digitization Epi-ilurnination Skap aukamatically when saturaked
Timer
Auto Range

(&) YES O MO

Option Description

YES During incrementalimaging, exposure is automatically stopped when the amount
of saturated data is too large.
NO During incremental imaging, exposure is continued until the Stop button is pressed.

ImageQuant LAS 4000 User Manual 28-9607-42 AC 107



5 Software reference guide
5.10 Edit menu

Digitization EPI

ImageQuant LAS 4000 Preference

D Cooling

Root Folder

File Farmat

FlatFrame Mode

Launch Application

Print Adjust

Increment

Digitization Epi-ilumination

Timer Invert pixel data
Auko Range

(*) YES O No

Option ‘ Description

YES Pixel data inversion is performed.

NO Pixel data inversion is not performed.

Timer

ImageQuant LAS 4000 Preference

CCD Cooling

Root Folder

File Format

FlatFrame Mode

Launch Application

Print Adjust

Increment

Digitization Epi-illumination

Timer Cooling Stop Timer
Auto Range

1hr v

If the ImageQuant LAS 4000 is not used during the chosen time, the cooling will be
automatically shut off and the system will enter power saving mode.
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5.10 Edit menu

Auto Range

ImageQuant LAS 4000 Preference

CCD Cooling

Rook Folder

File Farmat Auto Range selection in Repetition/Increment mode
FlatFrame Mode

Launch Application
Prink Adjust (&) None | J |
Increment

Digitization Epi-ilumination
Timer

Auto Range (O semiautomated | “ |

) aAutomated J‘

Animage whose gradations are adjusted automatically is displayed when exposure type
is Increment or Repetition.

* None

An image is displayed without adjusting its gradations.
* Semiautomated

An image is displayed with its light and shade highlighted.
e Automated

An image is displayed with its light and shade more highlighted. (The effect is the
same as when exposure type is Precision.)

511 View menu

Paint saturated data red

This function toggles whether to display saturated data in red.

Negative Gray

This sets the display color of an image such that absorbing bands are darker and the
background lighter.
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5.11 View menu

Positive Gray

Red

Green

Blue

This sets the display color of an image such that absorbing bands are lighter and the
background darker.

This sets the display color of an image such that illuminated regions are displayed in
red.

This sets the display color of an image such that illuminated regions are displayed in
green.

This sets the display color of an image such that illuminated regions are displayed in
blue.

Pan Focus All

This function toggles the quality of a focus image. The image is displayed in high image
quality when this option is selected.

Pan Focus Fast

110

This function toggles the quality of a focus image. With this option selected the image
quality is lower than using Pan Focus All, but it is displayed faster.

Tip: During sample alignment, a sample can be quickly aligned when Pan
Focus Fast is selected.
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5.12 Option menu

512 Option menu
5121 CCD Calibration

This function creates a correction file that is used for correcting characteristics of the
CCD detector. The created correction file varies depending on the sensitivity, exposure
time (short or long), and CCD cooling temperature.

1 When CCD Calibration is selected in the Option menu, the following window is

shown.
5 3 1 4
CCD Celibration
Currdnt Temperature -25
[ tomijionsectozhouws | [ over 2 hours
\
ead! ot Read:
D Thu Jul 2R14:5;:l6 2009 D N—t'R'—'y
ead! ot Read:
D Thu]u|2R14:5:‘31 2009 D N't'R"'y
ead! ot Read:
D Thu]uIZRH:S;:Sl 2009 D N't'P:"y
ead! ot Read:
D ThuJulZRH:S;Gl 2009 D N—t'R'—'y
D T fionss
Tokal Time for Calibration : O minutes
2 -
| ] o
Description : Description
1 Click here to check the boxes | 4 Click here to check the boxes
for all resolutions for up to 2 for all resolutions for more
hours. than 2 hours.
2 The time required for creation | 5 Click on the buttons in this
is displayed. column to check the boxes for

both correction files for specif-
ic resolutions.

3 Check individual check boxes
to generate specific correction
files.

2 Click the Start button to generate the file.
e The progress of file creation is shown on the progress bar.

* To stop file creation, click the Stop button. The file will not be saved.
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5.12 Option menu

5.12.2 Flat Frame Calibration

5122 Flat Frame Calibration

This function creates a correction file (Flat Frame) that is required for correcting the
optical characteristics. The Flat Frame file varies depending on Light, Filter, Iris, and Tray
Position.

Note: Administrator priveleges are required to perform Flat Frame calibration.

Flat Frame Calibration

112

1

[ I =GN EN \V

Select Flat Frame Calibration in the Option menu. The window below is then
displayed.

Applicatle Tray EFT Tray
Uniformity Standard  Calioration Plate DI
Calibrate all Tray Positian
Tray Position 1 ¥ Ready
Sun May 31 18:15:22 2009
Rt
Tray Position 2 ¥ o
Mon May 25 14/16.55 2009
Read:
Tray Pasition 3 0O Sl
Mo Py 25 1411736 2005
Rt
Tray Position 4 ¥ o
Mo Py 25 14 15 16 2003
Takal Time For Calibration : @ minutes
Start Stop

Close

Select a method from the drop-down menu at the top.
Put the displayed tray and Calibration Plate in the instrument.
Select the condition to be created.

Click the Start button.

Note: Make sure that an appropriate filter and tray are in place.
A message window opens when the calibration is completed. Click OK.

Click the Close button to close the FlatFrame Calibration window.
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5.12 Option menu
5.12.2 Flat Frame Calibration

Flat Frame Calibration Pro

1 If FlatFrame Calibration Pro is selected in the Option menu, the window of the
conditions preset in the Method/Tray position window will be displayed.

FlatFrame Calibration Pro

Light Filter Iris Tray Fosition
whits (Epi-Whits) Thraugh F2.8 z
Lens:  FLJINON WRF43LMD

ExposureTime

O auto
(&) Manual
File Marme

Put the appropriate tray and calibration plate in the instrument.
Set the exposure time.
Enter a file name.

Click the Start button.

g &~ W

5123 Method Setting

Method Setting is used to set the content displayed on the Method/Tray position screen.

Method Setting

Method List

Name Light Filter TIris ~
[Cyz (REE)] B Biue (EpiRGE) @ sisoi Foss
[cvz] B slue (EpiBlue) @ w50 Foss
[cy3 (REE)] B Green (ErivRaE) @ s7soFzn Fo.es
[Cy3] B Green(EpiGreer) (@ S7SDFz0 |FO.85
[Cys (RGEY] I red (Epirae) @ rs7o Foss
[cys] I red (EpiRed) @ re7o FosS
[DapT] W v Epiy @ L Fo.5
[Digitization Epi-ilumination] [ white (Epiwhite () Through | Fz.s
[Digitization Trans-iluminstion] [ White (Trans-white! () Through |F2.8 b

To delete a method, select the method to be deleted and click Delete.

Note: Only user-defined methods can be deleted.

e To edit a method, select the method to be edited and click Edit.
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5.12 Option menu
5.12.3 Method Setting

Note: Only user-defined methods can be edited.

¢ To add a method, click Add.
Result: The following dialog is displayed.

Method Setting

Mame: | Tomsethod

Filker:

@ra0 v

Tris: ‘FD .85 b4

Light: ‘-E\ue (Epi-Blue) v|

1 Enter a Name for the method.

2 Select appropriate settings for Light, Filter and Iris.

3 Click OK.
Note: Optical characteristics can be corrected using the Flat Frame Calibration
function for the added Method. See Section 5.12.2 Flat Frame Calibration,
onpagelle.

5.13 Help menu

User Manual
Opens the ImageQuant LAS 4000 User Manual in the default pdf browser.

Getting Started
Opens the Getting Started with ImageQuant LAS 4000 manual in the default pdf browser.

End-User License Agreement
Opens the End-User License Agreement in the default pdf browser.
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5.13 Help menu

Sensitivity/Resolution

The figure showing the relation between sensitivity and resolution is displayed. Click to
close the window.

Sensiivityfiesolution

14298

102120

About ImageQuant LAS 4000
Control Software

The version information of Image Reader is displayed.

Click to close the window.

ImageQuant™ LAS 4000
@ imagination ot work. VerSion 1 1
ey Build 1.1.0.17

ONTROL SOFTWARE Instrument Sit: 8675001

lBchnical sUPPOrt: hitp: | i, qelifesciences. comfcontact
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6 Installing ImageQuant LAS 4000 Control Software

6 Installing ImageQuant LAS 4000
Control Software

Administrator priveleges
required

All tasks related to software installation or uninstallation require a computer account
with administrator priveleges.

6.1 Installation sequence

Software installation is performed in the following sequence:
1 Install the USB contol driver

2 Install the USB function driver (Windows XP only)

3 Install the ImageQuant LAS 4000 Control Software

6.2 Install ImageQuant LAS 4000 Control Software under
Windows XP

Before you begin
Log in using a Windows account with administrator privileges.

Install the USB Control Driver
(Windows XP)

Step Action

1 Disconnect ImageQuant LAS 4000 from the computer.

2 Open the control panel and select Printers and Other Hardware.
3 Click Add Hardware.

4 Click the Next button in the Add hardware wizard.
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6.2 Install ImageQuant LAS 4000 Control Software under Windows™ XP

Step Action

5 Select Yes, | have already connected the hardware and click the Next button.
6 Select Add a new hardware device and click the Next button.
[
&

s ] Lo |

7 Select Install the hardware that | manually select from a list [Advanced]
and click the Next button.

8 Select Show All Devices and click the Next button.

9 Click the Have Disk button in the Add hardware wizard.
10 Insert the ImageQuant LAS 4000 Control Software DVD and click the Browse
button.
11 Select to install the driver from the ImageQuant LAS 4000 Control Software
DVD.
Lok i ;IjlmenuﬂLﬁSllﬂlﬂJl 4 Ofirm
[e]
b
D[_'I.iin :ﬂmmﬂpl.’!nﬂc'.ﬂllfl’l
e
WD;UW\N
My Compndes

Fie pace: “inl o [ ]

MyHetmed,  Filer of e
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6.2 Install ImageQuant LAS 4000 Control Software under Windows™ XP

Step

12

13

14

15

16

17

18

Action

Open the USB Control folder.

Levkin | 17) bnogeluant LAS 40000 < OF *m-
) (S Corira
E) B Fureten
My Flscser
Docurreris
Deikio
My Documents
My Compnder
(j Fie gons i v o=
My Natrah, Flen o rpe [Ccomce ]

Select the DevMng.inf file and click the Open button.

Ronk o | [ USS Connl O Q-
S

Hepeme  |Deviang s Qpen
Fiss o (Bl ]

Click the OK button in the Install from disk dialog.
Click the Next button in the Add hardware wizard.
Click the Next button again.

Click the Continue Anyway button in the Hardware Installation dialog.

Hardware Installation

Y} The satware you are installng for this hardiare:
FLA/LAS WSB Device Managment: Diiver

has not passed Windows Loga testing to veiiy ts compatibilty

with Windows XP. (Tell me why ihis testingis impartant)

Continuing your installation of this software may impair
o1 destabilize the conect aperation of your spstem
either immediately or in the future. Miciosoft strongly
recommends that you stop this installation now and
cantact the hardware vendor for software that has
passed Windows Logo testing.

STOP Instaliation

Click the Finish button to complete the driver installation.
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6.2 Install ImageQuant LAS 4000 Control Software under Windows™ XP

Install the USB function driver

(Windows XP)

Step

Action

1

Connect the computer and the ImageQuant LAS 4000 with a USB cable and
turn ON the power switch of ImageQuant LAS 4000. The scanner is automat-
ically detected by the computer.

In the Found New Hardware Wizard dialog, choose No, not this time.

Click the Next button in the Found New Hardware Wizard dialog.
Insert the installation DVD.

Select Install the software automatically (Recommended).

Click the Next button in the Found New Hardware Wizard dialog.

Click the Finish button to complete the installation.

Install ImageQuant LAS 4000
Control Software (Windows XP)

Step
1

2

Action

Insert the ImageQuant LAS 4000 Control Software DVD.

Locate and double-click the file ImageQuant LAS 4000.msi.

In the ImageQuant LAS 4000 - InstallShield Wizard, click the Next button.

Read the license text. If the license agreement is not acceptable please
contact a GE Healthcare representative, see back cover of this manual for
contact information.

Select I accept the terms in the license agreement and click the Next button.

ImageQuant LAS 4000 User Manual 28-9607-42 AC 119



6 Installing ImageQuant LAS 4000 Control Software
6.2 Install ImageQuant LAS 4000 Control Software under Windows™ XP

Step Action

5 Select destination folder in the dialog:
|§J ImageQuant LAS 4000 - InstallShield Wizard el
Destination Folder \ ‘
Click Mext to install to this folder, or click Change to install ko a different: folder, ‘
Install ImageQuarnt LAS 4000 ta:
Ct\Program Files!,
[ <Bao T Eets ][ Camesl |

o Click the Next button to install the software at the default folder C:\Pro-
gram Files.

e Click the Change button to install to a different folder.

6 Click the Install button in the installation dialog.
7 Click the Finish button.
8 Start the ImageQuant LAS 4000 Control Software. This will ensure that nec-

essary folders and files are created.

6.3 Install ImageQuant LAS 4000 Control Software under
Windows Vista

Before you begin
Log in using a Windows account with administrator privileges.
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6.3 Install ImageQuant LAS 4000 Control Software under Windows Vista

Install the USB Control Driver
(Windows Vista)
Note: During software installations, you may be asked to confirm your actions
in a dialog with the text Windows needs your permission to continue.

Enter an administrator password, if prompted, then click Continue to
proceed with the installation.

Step Action

1 Disconnect ImageQuant LAS 4000 Control Software from the computer.

2 Open the control panel and click Classic View in the upper left corner.

3 Open Add Hardware.

4 In the Add Hardware dialog, click the Next button.

5 Select Install the hardware that | manually select from a list (Advanced)

and click the Next button.

6 Select Show All Devices and click the Next button.

UV

7 Click the Have Disk button.
8 Insert the ImageQuant LAS 4000 Control Software DVD and click the Browse
button.
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6.3 Install ImageQuant LAS 4000 Control Software under Windows Vista

Step Action

9 Select to install the driver from the ImageQuant LAS 4000 Control Software
DVD.
% Locate File ==
Laok i | 4 DVD/CD-RW Diive [D:) Imageluant LAS -w[H [ < s s
2| Recent Items -
2= A te modif... | Lecation
= -'b Nalthrk -
Recent Places b i
. Public
- 8 Camputer
N = Floppy Disk Drive (&)
Desktop &, Local Dik [C:)
r | Windows
] | System32
adrmin J0+/0/CD-Riw Diive (D) ImageQuart LAS 400
e STORE N GO E2)
LY
Computer
[ "1
b :
Network
File name:; “.inf -
Files of ype Setup Information (]
10 Select the USB Control folder and click Open.
“% Locate File ==
Logkin: &% DVD/CD-RW Drive (D) Imageluant LAS 400 ~ @ (F 02 [~
T Hame Size Type Date modif... | Location
’;'} Files Currently on the Disc (2) -~
Recent Places
o USE Control
w ! k,l File Folder
LNEED
Desktop USE Function
F | }, File Folder
i 1;]
admin
L
Computer
[ "
=~
Metwork
File name “in -
Files o type Setup Information (i)
11 Select the file DevMng and click the Open button.
T =
L ar o=
T
[}
o
=
12 Click the OK button in the dialog Install from disk.
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6 Installing ImageQuant LAS 4000 Control Software
6.3 Install ImageQuant LAS 4000 Control Software under Windows Vista

Action
Click the Next button in the wizard Add hardware.
Click the Next button once again.

The following warning is displayed. Proceed by cliking Install this driver
software anyway.

%) Sew iy

Click the Finish button in the Add Hardware wizard to complete the instal-
lation.

Install ImageQuant LAS 4000
Control Software and USB
function driver (Windows Vista)

Note:

Step

During software installations, you may be asked to confirm your actions
in a dialog with the text Windows needs your permission to continue.
Enter an administrator password, if prompted, then click Continue to
proceed with the installation.

Action

Insert the ImageQuant LAS 4000 Control Software DVD.
Locate and double-click the file ImageQuant LAS 4000.msi.

In the ImageQuant LAS 4000 - InstallShield Wizard dialog, click the Next
button.

Read the license text. If the license agreement is not acceptable, please
contact a GE Healthcare representative. See the back cover of this manual
for contact information.

Select I accept the terms in the license agreement and click the Next button.
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6.3 Install ImageQuant LAS 4000 Control Software under Windows Vista

6.4

124

Step

5

10

Action

Select destination folder in the dialog:

Bl ImageQuant LAS 4000 - InstallShield Viizerd ==
Destination | older
Chek Nt o inetiall 1o Phis Pdder, o click Change o install bn a different Polder.

Enstall Imageluant LAS 4000 to:

._‘ C{Program Firs| Chingm,

<Back || Meat | e

o Click the Next button to install the software at the default folder C:\Pro-
gram Files.

e Click the Change button to install to a different folder.

Click the Install button.

If User Account Control (UAC) is enabled in Windows Vista, a dialog displays
the message An unidentified program wants access to your computer.
Click Allow.

Click Install this driver software anyway.

& Windows Secrty i

) See detsts

Click the Finish button.
Theinstallation of ImageQuant LAS 4000 Control Software is now completed.

Start the ImageQuant LAS 4000 Control Software. This will ensure that nec-
essary folders and files are created.

Install ImageQuant LAS 4000 Control Software under
Windows 7

Note:

Log in using a Windows account with administrator privileges before
attempting to install the software.
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6.4 Install ImageQuant LAS 4000 Control Software under Windows 7

Installation is performed in the following sequence.

1 Disable the computer sleep function

2 Installation of the USB Control driver

3 Installation of the ImageQuant LAS 4000 Control Software and USB function driver

Disable the computer sleep function

In order to prevent scanning errors, the computer should be set to never sleep as
described below.

1 Open the Control Panel and click System and Security. Click Change when the
computer sleeps below Power Options.

2 Select Never in the drop-down menu by Put the computer to sleep, then click Save
changes.

= Fimimes et + oo Cpirs + 484 P s <[4 - 2

[deshergm | | Gomn

Installation of the USB Control Driver (Windows 7)

Note: During software installations, you may be asked to confirm your actions
in a dialog with the text Windows needs your permission to continue.
Enter an administrator password, if prompted, then click Continue to
proceed with the installation.

1 Disconnect ProductNameHW from the computer.
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6.4 Install ImageQuant LAS 4000 Control Software under Windows 7

2 Open the control panel and click Hardware and Sound.

b Com Pt + -y 2

Adfust your computer's semsngt by Congey =

3 Click Device Manager under Devices and Printers.

4 Select Action:Add legacy hardware.

I-E_u—w

E mm——— |

O
...._".L.—,

o BVEATD 800 e
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6.4 Install ImageQuant LAS 4000 Control Software under Windows 7

5 Inthe Add Hardware dialog, click the Next button.

add Hardware

Walcome to the Add Hardware Wizard

Tha devver
devices thet do 4 suppeet Plug-and-Play and whh ars ot
asteratically recognaed by Wrsdoms.

o o ate an ach
you hinvs ben disectied b by technicel deppon.

A pour hardware came with an irstallation CD, it b
recammendad that you click Cancel 16, clote Phit wizsed

6 Select Install the hardware that | manually select from a list (Advanced) and click
the Next button.

add Hardware

Thes wizared can bl yous inatall cahor hardwsm

other hard for you. O, if you
E £ skt

Wt dhe o waed the wizard 1o de?
Search for

b () (o)

7 Select Show All Devices and click the Next button.

add Hardware

Fircam the bt bakow. snbect tha type of hanfesm yeu s inetallng

Cosnmen hardusse hypes

5 Onplay sdapters

W FLALAS S8 Divice

4100 ATAZATAS comtraliar:
s [EEE 13844 comptitis printer
A ITEL 13840 devices

§ [EEE 130 Bun hest contrellens
Sjlmaging devizes

I tntrared devices

[etmen ez ] [cmen ]
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6.4 Install ImageQuant LAS 4000 Control Software under Windows 7

8

10

11

128

Click the Have Disk button.

ad Hardware

Sbnct tha dervica. driver you wand 15 inatall for this handeans.

B
(Retrieving a It of all devaces)
Have Deak i
. e

Insert the ImageQuant LAS 4000 Control Software DVD and click the Browse button.

-
Tistall From Disk e s S————

u Insert the manufacturer’s installation disk, and then
= make sure that the comect drive is selected below

Ui

Copy manufacturer’s files from:

- Browss

Select to install the driver from the ImageQuant LAS 4000 Control Software DVD.

e =
Loskip W Computer - @Yoo

Devices with Nemevable Storage (4) &

Librarie
’_' ‘y Floppy Dok Orve (&)
. TVO/CO Rl Dot ]
| Compue | |58 bmageuans La5 03112
U ytes P o 575 bam
. USIR_DRY T}

Hetwork a
e - =

Stos o

Select the USB Control folder and click the Open button.
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6.4 Install ImageQuant LAS 4000 Control Software under Windows 7

12 Select the file DevMng and click the Open button.

T
Loskip ) USB Contel - @Fem
- Herme i Date moddied Type
o Fies Curmently on the Disc (1)
Fecent Pleces. &1 Bevhing LAAMEIMEM  Setuplnic
Desidop
=l
| Libraries
Comnputer
@ 5 y
Hetwork
e ooy T
Fies of e Set osnaton (of Cancel

13 Click the OK button in the Install from disk dialog.
14 Click the Next button in the Add Hardware wizard.

add Hardware

Sabnct thas devica driwer you want 1 inatall fnr this hardwars.

P

¥

e, ¥y have

Ml

TL/LAS USH Device Manaqerment Diriver

PR T —— [
Till o vy e i

Hrelak. |

[EET08 e Y

15 Click the Next button once again.

add Hardware

Thes wizare s rmacly b nitall your harhwars
Marchware to instalt:

Ta start installing your new hardheare, click Hee

FLALAS U150 Device Managemens Crrver

(BT [Comen ]
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6 Installing ImageQuant LAS 4000 Control Software
6.4 Install ImageQuant LAS 4000 Control Software under Windows 7

16 The following warning is displayed. Proceed by clicking Install this driver software
anyway.

e

# Don'tinstall this driver software

‘ou should check your manufacture’s website for updated diver software
for your device.

a3

Onby install driver sotware abtsined from your marfacturer's website oo
. Unsigmed software from other sounces may harm your computer of steal
indeamation

o) Fee detaily

17 Click the Finish button in the Add Hardware wizard to complete the installation.

ad Hardware

Complating the Add Hardware Wizard

The folowing hardware was initabedt
L FLALAS U5 Device Maagement Divw
-l

Windows his fnithed initabing the softwens fos Eh device.

Tos cleas thit wirard, click Finith.

B

Installation of the ImageQuant LAS 4000 Control Software and USB function
driver (Windows 7)

Note: During software installations, you may be asked to confirm your actions
in a dialog with the text Windows needs your permission to continue.
Enter an administrator password, if prompted, then click Continue to
proceed with the installation.

1 Insert the ImageQuant LAS 4000 Control Software DVD.
2 Locate and double-click the file ImageQuant LAS 4000.msi.
3 Inthe ImageQuant LAS 4000 - InstallShield Wizard dialog, click the Next button.

e T =

Welcome: Lo the InstatShickd Wicard lor
ImageQuant LAS 4000

The Instalishveid () Wianre wil instal ImageQuant LAS 4000 on
YO COMpUTE, T contrue, chok e |

|

|

|

|
\WARNING: Thvs qrogram m pratected by copymght s and l
interratiorsl yeates. |
|

|

|

|

|

|

&
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6 Installing ImageQuant LAS 4000 Control Software
6.4 Install ImageQuant LAS 4000 Control Software under Windows 7

4 Read the license text. If the license agreement is not acceptable, please contact a
GE Healthcare representative. See the back cover of this manual for contact
information.

Piense read the folming ierse agreement carefly, \ 4

GE Healthcare

STMMMW&RIWWT
LIFE SCIENCES SOF TWARE PRODUCTS

IMPOHTANT-PLEASE READ CAREFULLY

nlsﬁm:mﬂﬂcmmnmmmlsmnm
T BEFORE INSTALLING AND USING GE HCALTHCARE SOFTWARE.
FFLILLY HEAD ALL OF THE TERMS AND CONDITIONS OF THIS LICENSE
BEFORE i ANLVOR et

SHEEMENT PROCEEDING WITH THE DOWNLOALING
LT T ——— Com ]
L keense agreement
Instalshekd
(e e | ] |

Select I accept the terms in the license agreement and click the Next button.

5 Select the destination folder in the dialog:

Bestination Folder \
3k et i il b i Folder, o cick Change tn il bo & differnt fokder. | 4

I"_1 Irtall Imageuant LAS 4000 b
\ C: ¥rogram Ples) [ e, |

(BT e )|

e Click the Next button to install the software in the default folder C:\Program
Files.

* Click the Change button to select a different location.

6 Click the Install button.

Ready ta Install the Program
The wiziwed i reacdy b begie i tallation.

i Il to begn the retalaton,

Wyea e L
it tha wiased.

(BT e |

7 If User Account Control (UAC) is enabled in Windows 7, a dialog displays the
message An unidentified programs wants access to your computer. Click Allow.
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6 Installing ImageQuant LAS 4000 Control Software
6.4 Install ImageQuant LAS 4000 Control Software under Windows 7

8 Click Install this driver software anyway in the Windows Security dialog.
G Windows Securty ===y

s can't verify the publisher of this driver software

2 Don'tinstall this driver software
“Viow showld check your manufactures's website for updated driver scltmare
for your devce.

Onby install driver sotware abtsined from your marfacturer's website oo
e, Urnsigraed suftware from othes seurtes may harm yoar computes o seal
irdearnatien.

) See detals

9 Click the Finish button to complete the installation.

InstaBShiek! Wicard Compheled

The Instalicheedd Wizard Fas suctessfly rutaled ImsgeQuant
LAS 4000, Clck Firish to-exit the wizard,

Lisunch fmegeQuant LAS 4000
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7 Uninstalling and upgrading ImageQuant LAS 4000 Control Software

7/ Uninstalling and upgrading
ImageQuant LAS 4000 Control

Software

Before you begin

Log in using a Windows account with administrator privileges.

Uninstalling ImageQuant LAS
4000 Control Software under

Windows XP

Step Action

1 Open the control panel and select Add or Remove Programs.

2 Select ImageQuant LAS 4000 and click the Remove button.

Change or

Remove
Frograms

&

Add Wew
Proarams

AddjRemove
Windows
Components

@

Set Program
Access and
DefaLlts

8 4dd or Remove Programs

Currently installed programs and updates:

% ImageQuant LAS 4000

Click her

@ Intel(R) Graphics Media Accelerator Driver
B Intel(R) Management Engine Interface
EE Intel(R) Network Connections 13,1,33.0
B Intel® Active Management Technology
| %] Java(TM) & Update 7
#3 Microsoft MET Framework 1.1
8 Microsoft MET Framework 1.1 Hotfix (KES28366)
5! Microsoft MET Framework 2.0 Service Pack 2

§5) .NET Framework Prer

5 kBosE4a1

ﬁ! Dr. Whatson

§5) MET Framework CRT

5! MET Framework Ca

§5) MET Framework CLR

355 «NET Frameveork WinFarms

Show updates

Used

Size:
Size:
Size:

Size

Size:
Installed On
Installed On
Installed On
Installed On
Installed On
Installed On
Installed On

Remove

0.01MB
4.59MB
0.16MB

171.00MB

185.00MB
6/11/2009
6/11/2009
61172009
6/11/2009
6/11/2009
6112009
61172009
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7 Uninstalling and upgrading ImageQuant LAS 4000 Control Software

Note: Correction files created during calibration are required by the
ImageQuant LAS 4000 Control Software. They are not deleted during
the uninstallation, and remain in the Data folder of ImageQuant LAS
4000 Control Software folder.

Uninstalling ImageQuant LAS
4000 Control Software under
Windows Vista

Step Action

1 Open the control panel and Select Uninstall a program under Programs.
2 Select ImageQuant LAS 4000 and then click Uninstall.
R s e e e

3 Confirm the uninstallation by clicking Yes when prompted.

4 If User Account Control (UAC) is enabled in Windows Vista, a dialog displays
the message An unidentified program wants access to your computer.
Click Allow.

134 ImageQuant LAS 4000 User Manual 28-9607-42 AC



7 Uninstalling and upgrading ImageQuant LAS 4000 Control Software

Uninstalling ImageQuant LAS
4000 Control Software under

Windows 7
Step Action
1 Open the control panel and select Uninstall a program under Programs.
2 Select ImageQuant LAS 4000 and then click Uninstall.

q [ e

3 Confirm the uninstallation by clicking Yes when prompted.

4 If User Account Control (UAC) is enabled in Windows 7, a dialog displays the
message An unidentified program wants to access your computer. Click

Allow.

Upgrading ImageQuant LAS 4000
Control Software

Step Action

1 Uninstall the current version of ImageQuant LAS 4000 Control Software.

2 Install the new version of ImageQuant LAS 4000 Control Software.
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8 After-sales service

8.1

8.2

136

After-sales service

Warranty

1 The warranty period will expire after 1 year from the date the system was delivered.

2 GE Healthcare will make repairs free of charge for failures during the warranty period,
provided that normal usage conditions and the instructions given in this manual,
etc., are followed.

3 Repairs of the following failures will be charged for even if the warranty period has
not yet expired.
e Problems caused by incorrect usage and/or by any products other than those

authorized by GE Healthcare and/or problems caused by other equipment.
e Problems and/or damage due to moving, transport and/or falling.
Repairs

1 Before asking for repairs, refer to the troubleshooting section in Getting Started with
ImageQuant LAS 4000.

2 If the problem persists, fill in the service report fax sheet at the end of this manual
and contact your GE Healthcare representative.

3 The guaranteed repair service period of this product is 5 years from the termination

of sales. Thereafter, repair service may not be provided if repair parts become out
of stock.

ImageQuant LAS 4000 User Manual 28-9607-42 AC



A Appendix

Appendix A Appendix

A.l  Glossary

CCD Calibration

Electric charges are accumulated on the CCD even if it is not exposed to light. The
accumulated electric charge is called a dark current noise. The process for eliminating
the noise component is performed by CCD calibration. The image constituted by the
dark current noise is called CCD calibration data. An image that is constituted by only
the electric charges accumulated during exposure can be created by subtracting the
CCD calibration data from the exposed image.

Flat Frame

In an exposure system using a 2D sensor such as a CCD, unevenness due to the lens or
lighting system appears on the image. By correcting the unevenness, an object that
radiates light at the same brightness is represented evenly in any section of an exposure
area. A correction file for correcting unevenness is called a flat frame. Under the same
conditions (tray position, iris, fluorescent filter, light source, and tray) as when exposing
an object sample, a flat frame records the image in a uniform fluorescent plate
(fluorescent mode) or white plate (digitize mode).
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A Appendix
A.1 Glossary

Conceptual diagram of CCD calibration and flat frame

Sample image

Raw image
Virtual profile in which
light is supposed to be
uniformly emitted from
the whole image |
Center
CCD Calibration Data State of image that
. is not corrected
Center
Z| Raw image—CCD Calibration Data
Electrical noise
component s n
Center
FlatFrame
Removal of noise
) component
Center
Xraw image—CCD Calibration Data),”
'Optical unevenness' ) FlatFrame
Center

Limb darkening due to
. optical characteristics

Center

A.2  Quick-reference functions
Function ‘ Function name Set item
Exposing for afixed expo- | Exposure Type Precision
sure time
Exposing consecutively Exposure Type Increment
Exposing repeatedly Exposure Type Repetition
Determining exposure Exposure Time Auto
time automatically
Entering and determining | Exposure Time Manual
exposure time
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Function

Determining a desired
exposure time and ex-
pose.

Setting the exposure
time and the exposure
intervals.

Function name

Exposure Type

Exposure Type

A Appendix
A.2 Quick-reference functions

Set item

Program

Program settings

Setting sensitivity and
resolution

Sensitivity/Resolution

High Resolution

Standard

High

Super

Ultra

High Binning

Super Binning

Ultra Binning
Exposing a chemilumines- | Add Digitization Image On
cence and a digitized
(white epi-illuminated)
image by single-click op-
eration
Method Chemiluminescence

Selecting detection
method

Fluorescence:EtBr

Fluorescence:SYBR Green

Fluorescence:GFP

Fluorescence:Cy3

Fluorescence:Cy5

Fluorescence:Dy781

Fluorescence:DAPI

Digitization:DIA

Digitization:EPI
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A Appendix
A.2 Quick-reference functions

Function ‘ Function name Set item ‘
. . Method/Tray position Select the tray position

Changing tray position from 1 to 4.

Focusing Fine-adjust the light using
Adjusting focus Brightness and the focus

using Adjust.

Starting exposure Start

Edit:Preference Yes

Inverting image data

Digitization Epi-illumina-
tion tab

Invert pixel data

Saving a file in TIFF for-
mat

Edit:Preference

File Format tab

Select a 16-bit Linear TIFF
format

Saving window image di-

Edit:Preference

Select an 8-bit Color TIFF

rectly File Format tab format

Changing the tempera- = Edit:Preference Set the temperature
ture setting of CCD CCD Cooling tab

Changing the folder of Edit:Preference Specify the folder where
file saving Root Folder tab afile s saved
Fine-adjusting the print | Edit:Preference Enter size in percent
size Print Adjust tab

Displaying saturatedda- | View:Paint saturated data | Select and check
tainred Red

Displayingimage in Neg-
ative Gray

View:Negative Gray

Select and check

Displaying image in Posi-
tive Gray

View:Positive Gray

Select and check

Creating CCD Calibration
file

Option:CCD Calibration

Select and set conditions
for Start

Creating Flat Frame

Checking software ver-
sion information

Option:Flat Frame Calibra-
tion

Help:About ImageQuant
LAS 4000 Control Software

Select and set conditions
for Start

Select

140
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A Appendix
A.2 Quick-reference functions

Function Function name Set item

Checkingtherelationbe- | Help:Sensitivity/Resolution | Select
tween sensitivity and
resolution

A.3  Detection Reagents and corresponding settings

Note: The RGB module may be used instead of the separate red, green and
blue Epi lights.

ImageQuant LAS 4000 setting

Classification Reagent —
name Method Light Filter Iris
ECL Chemiluminescence none Through 0.85
ECL Plus Chemiluminescence none Through 0.85
Lumi-Light Chemiluminescence none Through 0.85
Plus

Chemiluminescence Renaissance | Chemiluminescence none Through 0.85
Super Signal Chemiluminescence none Through 0.85
Bright-Star Chemiluminescence none Through 0.85
CDP-Star Chemiluminescence none Through 0.85
CSPD Chemiluminescence none Through 0.85
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A Appendix
A.3 Detection Reagents and corresponding settings

Reagent ImageQuant LAS 4000 setting ‘

Classification
name Method Light Filter Iris

EtBr Fluorescence:EtBr uv(312nm 605DF40 2.8
Trans)

Cy2 Fluorescence:SYBR Blue (460nm | Y515-Di 0.85
Green Epi)

SYBR Green | Fluorescence:SYBR Blue (460nm | Y515-Di 0.85
Green Epi)

SYBR Green Il | Fluorescence:SYBR Blue (460nm | Y515-Di 0.85
Green Epi)

SYBR Gold Fluorescence:SYBR Blue (460nm | Y515-Di 0.85
Green Epi)

SYPRO Ruby Fluorescence:SYBR Blue (460nm | Y515-Di 0.85
Green Epi)

SYPRO Or- Fluorescence:SYBR Blue (460nm | Y515-Di 0.85
ange Green Epi)

SYPROtanger- | Fluorescence:SYBR Blue (460nm | Y515-Di 0.85

ine Green Epi)
Fluorescence dye .
FITC Fluorescence:SYBR Blue (460nm | Y515-Di 0.85
Green Epi)
FAM Fluorescence:SYBR Blue (460nm | Y515-Di 0.85
Green Epi)
EGFP Fluorescence:GFP Blue (460nm | 510DF10 | 0.85
Epi)
ECFP Fluorescence:GFP Blue (460nm | 510DF10 | 0.85
Epi)
RITC Fluorescence:Cy3 Green 575DF20 | 0.85
(520nm Epi)
Cy3 Fluorescence:Cy3 Green 575DF20 | 0.85
(520nm Epi)
Cy5 Fluorescence:Cy5 Red (630nm | R670 0.85
Epi)
Alexa 633 Fluorescence:Cy5 Red (630nm | R670 0.85
Epi)
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Classification

Reagent
name

A Appendix
A.3 Detection Reagents and corresponding settings

ImageQuant LAS 4000 setting

Method

Filter

Iris

Alexa 660 Fluorescence:Cy5 Red (630nm | R670
Epi)
Alexa 680 Fluorescence:Cy5 Red (630nm | R670 0.85
Epil
Q-dot Fluorescence:DAPI UV (365nm L41 2.8
Epi)
Dy781 Fluorescence:IR Infrared IR785 0.85
(710nm Epi)
Alexa 680 Fluorescence:IR Infrared IR785 0.85
(710nm Epi)
Alexa 700 Fluorescence:IR Infrared IR785 0.85
(710nm Epi)
Attophos 1 Fluorescence:SYBR Blue (460nm | Y515-Di 0.85
Fluorescence dye Green Epi)
(Chemifluorescence) ECL Plus Fluorescence:SYBR Blue (460nm | Y515-Di | 0.85
Green Epi)
Silver stain Digitization:Trans White (Trans) | Through 2.8
CBB stain Digitization:Trans White (Trans) | Through 2.8
Digitization
X-ray film Digitization:Trans White (Trans) | Through 2.8
NBT/BCIP Digitization:Epi White (Epi) Through 2.8

1 Attophos cannot be used for detecting nucleic acid on a nylon membrane.

Note:

With regard to patents owned by third parties related to, among other
things, sample preparation, we recommend that you consult with a

lawyer or patent attorney about obtaining a license from the third
parties.

A.4  Main specifications

CCD

3200 000 pixels (Fujifilm super CCD)

Cooling temperature

-25°C
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A Appendix
A.4 Main specifications

Number of grada-
tions

Recorded image:

Focusing:

16 bit

8 bit

Exposure time

Lens

1/100 seconds to 2 ho

urs

(Images can be continuously exposed for up to 30 hours using ImageQuant
LAS 4000 Control Software.)

High-sensitivity lens F0.85 43 mm

Wide view lens F1.8 24 mm

Shading correction

Software system

Maximum sample
size

250 x 250 mm with F1.8 24 mm lens
210 x 140 mm with F0.85 43 mm lens

Dynamic range

4 orders of magnitude

Maximumimagesize | 12.6 MB
Light source Epi (class 1 light source)
Blue Epi light 1460 nm
Green Epi light 1520 nm
Red Epi light 1630 nm
RGB Module (Epi light)  : 460 nm, 520 nm or 630 nm
NIR Epi light :710 nm
Epi and Trans (class 1M light source)
UV Epi light 1365 nNm
UV transilluminator :312nm
Size 1322%x313x87mm
UV transmitted filter size 200 x 200 mm
White transmitted light table  : White LED
Size 1322 %x313x87mm
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External dimensions

Camera head

IDX

1224 x 161 x 252 mm (W/H/D)

510 % 730 x 480 mm (W/H/D)

A Appendix
A.4 Main specifications

Weight

Power requirements

Camera head

IDX

High-sensitivity lens  : 4.5 kg

Input voltage
Voltage variation
Phase

Power frequency

Rated input current  :3.0-1.5A

AC power cable

Use the cable supplied with the instrument.

Specifications of cables required for the use of ImageQuant LAS 4000

Voltage :100-120V
Plug/connector 1125V AC 13 A
Cable :SJT3 x 16AWG 60°C

Power supply cord length  : Maximum 3 m

Voltage :200-240V
Plug/connector 1250V AC, 10A
Cable - CENELEC OC 3 x 1.0 mm? 70°C

Power supply cord length  : Maximum 3 m

3.4 kg

:49 kg (notincluding the light source, lens, and tray)

:100-240 V~

1 +/-10%

: Single phase
:50/60 Hz
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A Appendix

A.4 Main specifications

Installation condi-
tions

146

Placement conditions

Free space required around ImageQuant LAS 4000

Rear :200 mm
Top : 1000 mm
Table strength

Other conditions

1

Floor

Secure space for maintenance work as follows:

Front  :600 mm
Right  :600 mm

Left :600 mm

The allowable load must be 981 N/m? (100kg/m?) or greater.

Decide on an installation location taking into consideration the work
flow and ancillary facilities to be used.

Required construction work and electricity/air conditioning work must
be completed in advance.

Itis not desirable to have a heat source on the IDX right side face where
there is an air intake fan even if the environmental requirements have
been met.

Do not install the equipment near a window to avoid direct sunlight.
Attach a blind to nearby windows.

Do not place objects near the power outlet so that you can disconnect
the power cable from the outlet in case of emergency.

oscillation conditions

(1) Operating time Oscillation  :0.03G (5 to 60 Hz)
Impact 111G
(2) Non-operating time  Oscillation  :0.4G (5 to 60 Hz)

Impact :2G
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A Appendix
A.4 Main specifications

Environmental conditions

Operating temperature/humidity conditions

Temperature  :15°C to 28°C (with temperature fluctuation
below 10°C per hour or lower)

Humidity 30%t0o 70 % RH  (no dew condensation)

When the above conditions cannot be satisfied, modify the facilities
accordingly.

Transportation/storage conditions

Temperature  :-25°Cto 70°C

Humidity 5% to 100 % RH (no dew condensation)

Installation location conditions

1 Do notinstall the equipment in an area where the temperature varies
widely.

2 Do not install the equipment near a source of heat.
3 Do notinstall the equipmentin an area where it may get wet or flooded.

4 Do not install the equipment in an area where it may be exposed to
corrosive gas.

5 Do not install the equipment in a dusty area.

6 Do not install the equipment in an area constantly or excessively ex-
posed to oscillations or impacts.

7 Do not install the equipment in an area exposed to direct sunlight.

Operation site :Indoors

Maximum operating altitude : 2000 m or lower
Overvoltage category category Il : Transient overvoltage
Rated pollution applied : Pollution Degree 2

Analysis unit inter- USB 2.0

face
Do not connect the ImageQuant LAS 4000 USB connector to a computer

not certified with UL60950-1 (UL listed) and IEC60950-1.
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A.4 Main specifications

Others Noise : 70 dB (A) or lower

A.5 Minimum computer requirements

Operating system | Microsoft™ Windows XP SP3 (32-bit)
or
Microsoft Windows Vista Business SP2 (32-bit)
or
Microsoft Windows 7 Professional (32-bit)

Memory 1 GB or more
Processor Intel Core 2 Duo processor
HD 80 GB or more

USB port version UsB 2.0

Optical drives DVD-ROM

Monitor resolution | 1280 x 1024 pixels or more
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A.6

Service report fax sheet

To:

A Appendix
A.6 Service report fax sheet

SERVICE REPORT FAX SHEET

1) Company name

Customer information

2) Person in charge

3) TEL

4) FAX

5) E-mail

ImageQuant LAS 4000 system information

6) Serial No.

e Camera head

e Others

7) Analyzing unit type

e Operating environment

e Machine model

Windows

8) Usage frequency

9) Trouble occurrence frequency

10) Error code and failure description
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